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1.1  Intended use

The ALTOSONIC 5 is a flowmeter for flow measurement of all liquids. It has a custody transfer 
approval for all liquids other than water.

1.2  Certifications

European Union (EU):European Union (EU):European Union (EU):European Union (EU):

• Pressure Equipment Directive 97/23/EC
• EMC directive 2004/108/EC, according to:

EN 50081-2
EN 61000-6 (part 1, 2 and 3)
EN 61326-1 and A1, A2

• ATEX directive 94/9/EC according to:
EN 60079-0
EN 60079-1 (Ex 'd')
EN 60079-11 (Ex 'ia')

• Custody transfer approvals according to:
MID directive 2004/22/EC ((MID = Measurement Instrument Directive)
OIML R117-1 (International Organization for Legal Metrology)

North America:North America:North America:North America:

• Certified for use in potentially explosive atmospheres according to DIV1 and Zone 1 
classification.

• Custody transfer in compliance with API

Canada:Canada:Canada:Canada:

• CRN
• Certified for use in potentially explosive atmospheres according to DIV1 and Zone 1 

classification.

Other standards:Other standards:Other standards:Other standards:

• IECEx according to:
IEC 60079-0
IEC 60079-1
IEC 60079-11

CAUTION!
Responsibility for the use of the measuring devices with regard to suitability, intended use and 
corrosion resistance of the used materials against the measured fluid lies solely with the 
operator.

INFORMATION!
The manufacturer is not liable for any damage resulting from improper use or use for other than 
the intended purpose.
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1.3  Safety instructions from the manufacturer

1.3.1  Copyright and data protection

The contents of this document have been created with great care. Nevertheless, we provide no 
guarantee that the contents are correct, complete or up-to-date.

The contents and works in this document are subject to copyright. Contributions from third 
parties are identified as such. Reproduction, processing, dissemination and any type of use 
beyond what is permitted under copyright requires written authorisation from the respective 
author and/or the manufacturer.

The manufacturer tries always to observe the copyrights of others, and to draw on works created 
in-house or works in the public domain.

The collection of personal data (such as names, street addresses or e-mail addresses) in the 
manufacturer's documents is always on a voluntary basis whenever possible. Whenever 
feasible, it is always possible to make use of the offerings and services without providing any 
personal data.

We draw your attention to the fact that data transmission over the Internet (e.g. when 
communicating by e-mail) may involve gaps in security. It is not possible to protect such data 
completely against access by third parties. 

We hereby expressly prohibit the use of the contact data published as part of our duty to publish 
an imprint for the purpose of sending us any advertising or informational materials that we have 
not expressly requested. 

1.3.2  Disclaimer

The manufacturer will not be liable for any damage of any kind by using its product, including, 
but not limited to direct, indirect or incidental and consequential damages. 

This disclaimer does not apply in case the manufacturer has acted on purpose or with gross 
negligence. In the event any applicable law does not allow such limitations on implied warranties 
or the exclusion of limitation of certain damages, you may, if such law applies to you, not be 
subject to some or all of the above disclaimer, exclusions or limitations. 

Any product purchased from the manufacturer is warranted in accordance with the relevant 
product documentation and our Terms and Conditions of Sale. 

The manufacturer reserves the right to alter the content of its documents, including this 
disclaimer in any way, at any time, for any reason, without prior notification, and will not be liable 
in any way for possible consequences of such changes.

INFORMATION!
Not all country specific approvals are listed here. Please consult KROHNE in case of a specific 
approval that is not listed here.
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1.3.3  Product liability and warranty

The operator shall bear responsibility for the suitability of the device for the specific purpose. 
The manufacturer accepts no liability for the consequences of misuse by the operator. Improper 
installation or operation of the devices (systems) will cause the warranty to be void. The 
respective "Standard Terms and Conditions" which form the basis for the sales contract shall 
also apply.

1.3.4  Information concerning the documentation

To prevent any injury to the user or damage to the device it is essential that you read the 
information in this document and observe applicable national standards, safety requirements 
and accident prevention regulations.

If this document is not in your native language and if you have any problems understanding the 
text, we advise you to contact your local office for assistance. The manufacturer can not accept 
responsibility for any damage or injury caused by misunderstanding of the information in this 
document.

This document is provided to help you establish operating conditions, which will permit safe and 
efficient use of this device. Special considerations and precautions are also described in the 
document, which appear in the form of icons as shown below.
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1.3.5  Warnings and symbols used

Safety warnings are indicated by the following symbols.

•  HANDLINGHANDLINGHANDLINGHANDLING
This symbol designates all instructions for actions to be carried out by the operator in the 
specified sequence.

i RESULTRESULTRESULTRESULT
This symbol refers to all important consequences of the previous actions.

1.3.6  Manufacturer

The instrument is developed and manufactured by:
KROHNE Altometer
Kerkeplaat 12
3313 LC Dordrecht
The Netherlands

For information, maintenance or service please contact your nearest local KROHNE 
representative. 

DANGER!
This warning refers to the immediate danger when working with electricity.

DANGER!
This warning refers to the immediate danger of burns caused by heat or hot surfaces.

DANGER!
This warning refers to the immediate danger when using this device in a hazardous atmosphere.

DANGER!
These warnings must be observed without fail. Even partial disregard of this warning can lead to 
serious health problems and even death. There is also the risk of seriously damaging the device 
or parts of the operator's plant.

WARNING!
Disregarding this safety warning, even if only in part, poses the risk of serious health problems. 
There is also the risk of damaging the device or parts of the operator's plant.

CAUTION!
Disregarding these instructions can result in damage to the device or to parts of the operator's 
plant.

INFORMATION!
These instructions contain important information for the handling of the device.

LEGAL NOTICE!
This note contains information on statutory directives and standards.
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1.4  Safety instructions for the operator

DANGER!
• Do not change the device. Unauthorized changes may affect the explosion safety of the 

devices.
• The prescriptions and regulations as well as the electrical data described in the EC type 

examination certificate must be obeyed.
• Beside the instructions for electrical installations in non-hazardous locations according to 

the applicable national standard (equivalent to HD 384 or IEC 364, e.g. VDE 0100), especially 
the regulations in EN 60079-14 "Electrical installations in hazardous locations" or equivalent 
national standard (e.g. DIN VDE 0165 Part 1) or dust hazardous areas such as EN 61241-14 
must be strictly followed.

• Installation, establishment, utilization and maintenance are only allowed to be executed by 
personnel with an education in explosion safety!
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2.1  Scope of delivery

INFORMATION!
Do a check of the packing list to make sure that you have all the elements given in the order.

INFORMATION!
The instrument is delivered in a seaworthy, reinforced wooden crate. Inspect the packing 
carefully for damages or signs of improper handling. Report damage to the carrier and to the 
local office of the manufacturer.

Figure 2-1: Scope of delivery

1  Product documentation
2  CE declaration of conformity
3  Flow sensor in ordered version
4  Signal converter
5  Three signal cables, one PT100 cable
6  Optional: flow conditioner, spare parts and / or installed impact indicators

CAUTION!
When multiple meters are delivered, check the serial number on each part so that each flow 
sensor is accompanied by its own spoolpiece, flow conditioner and signal converter.

INFORMATION!
Calibration reports and project specific documents are in the meter's databook that is sent 
separately.
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2.2  General device description

The ALTOSONIC 5 flowmeter consists of a flow sensor and a signal converter.

2.2.1  Flow sensor

A series of ultrasonic transducers are installed in the measuring tube of the flow sensor. Each 
pair of intrinsically safe ultrasonic transducers forms an acoustic measurement path. The 
acoustic measurement path consists of one (direct) chord. 
The chords in the horizontal plane are used for flow measurement, the chord in the vertical 
plane is used for diagnostics only.

The transducers are electrically connected to the connection box on top of the flow sensor by 
means of coaxial cables.

Acoustic signals are transmitted and received by means of ultrasonic transducers. The active 
part of an ultrasonic transducer is a small disk of piëzo electric ceramic in the front of the 
transducer. It is packaged (sealed)  in a construction of metal parts and installed behind a metal 
acoustic window. The transducer itself is not exposed to the measured liquid. The window is 
designed to achieve the best efficiency for transmitting and receiving ultrasound through the 
liquid. 
The transducers can be exchanged under process conditions without the use of special tools 
such as a retraction tool, if the conditions are not extremely hot or cold. However, special tooling 
is required to remove the inner part of the transducer and the piezo that can stick to the steel 
window.

Figure 2-2: Flow sensor
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2.2.2  The signal converter

Figure 2-3: Signal converter

Number Board name Function Short name

1 Power Supply Board 
Intrinsically IS

Intrinsically safe power 
supply

PSB IS

2 Digital Processor Board calculation of flow rate DPB

3 Monitoring 
Configuration and 
Diagnostic

Logging and 
communication

MCD

4 SMART IO Configurable IO SMART IO

5 RS485 IO Board 4x RS485 Serial 
communication port

RS485

6 Power Supply Board Power supply for all 
cards in signal 
converter

PSB

7 Analog Processor Board Processes the analog 
signals from the flow 
sensor

APB

8 Multiplex Board Connection of the 
analog signals 
(transducers and body 
temperature) from the 
flow sensor to the APB

MUX

INFORMATION!
Detailed descriptions and connections can be found in Chapter 4.
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2.2.3  Cable glands and cables

The flow sensor and signal converter are installed mostly in a hazardous area. To achieve 
compliance with the certifications, it is mandatory that the flow sensor and the signal converter 
are installed with the supplied cables and cable glands. If other cables and / or cable glands are 
used, then these certificates are void.

2.2.4  Software description

The ALTOSONIC 5 uses powerful microprocessors which are configured by a specific set of 
parameters to enable the measurement of various sizes and models of flowmeters.

Individual parameters are classified according to “roles” in order to define differentiated access 
rights. Each “role” is associated with a “typical” user or operator having specific responsibilities 
and/or duties. Users have to be registered with a user name and a password,  when registered 
the role of the user is also defined, and by consequence also the access rights of that user.

The following roles have been defined, listed in according to the rank in the hierarchy.

Roles and authorisation

Only a higher rank user can register a lower rank user.  Users can have the same rank.

In addition to restrictions depending of the defined role of a user, a physical “overwrite disable” 
contact / jumper protects the configuration parameters. This disables any user from making 
modifications to parameters that would influence the measured flow or volume value.  This 
prevents unintentional or unauthorized changes to the parameters and possibly invalidation of 
the calibration.

Normally the flowmeter is delivered as a calibrated instrument. Therefore the configuration 
parameters are meter specific and can not be changed. Other parameters such as IO 
parameters on frequency outputs and communication are application specific and can be 
changed if needed. Any change in configuration is logged with time/date/user/previous value. 
This information can be retrieved afterwards for auditing and verification purposes.

LEGAL NOTICE!
The parameters are stored in a configuration file. Configuration parameters are password 
protected in order to prevent unauthorized modification.  Access in order to read, view and 
inspect parameter values is restricted by the type of user.

Factory restricted to KROHNE factory employees, to implement factory settings in the 
meter.

Service restricted to authorized service personnel, to the discretion of KROHNE.

Calibrator restricted to personnel acting on behalf of a legal calibration station.

Supervisor restricted to personnel acting on behalf of the owner/operator of 
the meter (administrator function), to the discretion of the owner/operator of the 
meter.

Operator restricted to personnel  acting on behalf of the owner/ operator of the meter (for day 
to day operation), to the discretion of the owner/operator of the meter.
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2.3  Ex approval standards and markings

The flowmeter consists of a flow sensor and a signal converter, that are designed to meet 
explosion safety requirements based on:

• an intrinsic safe flow sensor
• an explosion proof signal converter

2.3.1  Approvals

The device is manufactured according to the European Directive 94/9/EC (ATEX), to IEC 
standards for hazardous areas, to ISA/ANSI DIV 1 Canadian and US standards for hazardous 
locations. The flowmeter is approved for installation and use in hazardous locations of Zone 1 
and 2 and are in accordance with the European, Canadian and US Standards of the IEC/EN 60079, 
ANSI/ISA 60079, CSA C22.2 series. The approval numbers are:

Flow sensor
• ATEX: FTZU 14 ATEX 14.0131XATEX: FTZU 14 ATEX 14.0131XATEX: FTZU 14 ATEX 14.0131XATEX: FTZU 14 ATEX 14.0131X
• IECEx: IECEx FTZU 14.0020XIECEx: IECEx FTZU 14.0020XIECEx: IECEx FTZU 14.0020XIECEx: IECEx FTZU 14.0020X
• DIVISION (Ca & USA): LR 1338-1DIVISION (Ca & USA): LR 1338-1DIVISION (Ca & USA): LR 1338-1DIVISION (Ca & USA): LR 1338-1
• ZONE (Ca & USA): LR 1338-1ZONE (Ca & USA): LR 1338-1ZONE (Ca & USA): LR 1338-1ZONE (Ca & USA): LR 1338-1

Signal converter
• ATEX: FTZU 14 ATEX 0042XATEX: FTZU 14 ATEX 0042XATEX: FTZU 14 ATEX 0042XATEX: FTZU 14 ATEX 0042X
• IECEx: IECEx FTZU 14.0029XIECEx: IECEx FTZU 14.0029XIECEx: IECEx FTZU 14.0029XIECEx: IECEx FTZU 14.0029X
• DIVISION (Ca & USA): LR 1338-2DIVISION (Ca & USA): LR 1338-2DIVISION (Ca & USA): LR 1338-2DIVISION (Ca & USA): LR 1338-2
• ZONE (Ca & USA): LR 1338-2ZONE (Ca & USA): LR 1338-2ZONE (Ca & USA): LR 1338-2ZONE (Ca & USA): LR 1338-2

2.3.2  Standards

Flow sensor
The flow sensor is manufactured in accordance with:

• IEC/EN 60079-0 General requirements
• IEC/EN 60079-11 Intrinsic Safety
• CSA C22.2 No. 60079-0 
• CSA C22.2 No. 60079-11 
• CSA C22.2 No. 94 
• CSA C22.2 No. 157 
• CSA C22.2 No. 61010-1-12 
• ANSI/ISA 600079-0
• ANSI/ISA 60079-11
• NEMA 250 
• ANSI/UL913 
• ANSI/ISA 61010-1

It is designed to be used for gas group IIC and temperature classes T6...T2 and has an ingress 
protection rating of IP66 or NEMA Type 4X.
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Signal converter
The signal converter is manufactured in accordance with:

• IEC/EN 60079-0 General requirements
• IEC/EN 60079-1 Flameproof enclosure
• IEC/EN 60079-11 Intrinsic Safety
• CSA C22.2 No. 60079-0 
• CSA C22.2 No. 60079-11 
• CSA C22.2 No. 94 
• CSA C22.2 No. 157 
• CSA C22.2 No. 30
• CSA C22.2 No. 61010-1-12 
• ANSI/ISA 600079-0
• ANSI/ISA 60079-11
• NEMA 250 
• ANSI/UL913 
• ANSI/UL1203
• ANSI/ISA 61010-1

It is designed to be used for gas group IIB and temperature class T5.

2.3.3  Flow sensor markings

The flow sensor is certified as group II, category 2G equipment for gas hazardous areas zone 1 
and 2, group IIC, temperature class T6...T2 and has an enclosure protection of IP66 or NEMA 
Type 4x.

Ex marking

Ambient temperature

Flow sensor approval Marking

IECEx Ex ia IIC T6…T2 Gb

ATEX  II 2G Ex ia IIC T6…T2 Gb 

DIV 1 Class I, Groups B, C, D, temp class T6…T2

Zone (Canada) Ex ia IIB+H2 T6…T2 Gb

Zone, ANSI/ISA (USA) Class I, Zone 1, AEx ia IIB+H2 T6…T2 Gb

Version Ambient temperature (Ta)

Standard version (STD) -20°C...+65°C

Low ambient temperature (LTA) -55°C...+65°C
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Process temperature

The temperature limits apply under the following conditions:

• The instrument is installed and operated in accordance with the installation directions given 
in the manual.

• The instrument is solar protected and is not installed close to an external heat source.

The flow sensor contains the following intrinsic safety circuits:

Version Name Process temperature (Tp)

Standard version (STD) UFS 5-R-Ex -40°C...+120°C

Low process temperature (LT) UFS 5-R-LT-Ex -200°C...+120°C

High process temperature (HT) UFS 5-R-HT-Ex -40°C...+250°C

High viscosity (HV) UFS 5-R-HV-Ex -40°C...+120°C

Temperature class Maximum process temperature [ºC] at Ta = 65ºC

Standard 
version

HV version HT version LT version

T6 50 50 70 70

T5 85 85 85 85

T4 120 120 120 120

T3 - - 185 -

T2 - - 250 -

Circuit Parameters

Transducer circuit between flow sensor and signal 
converter

Ui = 18 V

Ii = 210 mA

Ci = 100 nF

Li = 700 μH

Pi = 1 W

PT100 circuit between flow sensor and signal 
converter

Ui = 10 V

Ii = 10 mA

Pi = 200 mW
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2.3.4  Signal converter markings

The  signal converter is certified as group II, category 2G equipment, fitted with non-Ex ia signal 
in/outputs. It is suitable for installation in gas hazardous areas zone 1 or 2, gas group IIB, 
temperature class T5 and has an enclosure ingress protection of IP66 or Type 4x.

Ex marking

The converter housing is a flameproof/explosionproof enclosure and is available in two variants.

Ambient temperature

Electrical data

Signal converter approval Marking

IECEx Ex d[ia] IIB T5 Gb

ATEX II 2G Ex d[ia] IIB T5 Gb

DIV 1 Class I, Groups B, C, D, temp class T5 

Zone (Canada) Ex ia IIB+H2 T5 Gb

Zone, ANSI/ISA (USA) Class I, Zone 1, AEx d[ia] IIB+H2 T5 Gb

Version Ambient temperature (Ta)

ATEX/IECEx/DIV1/Zone CA/ANSI-ISA EJB-4 ALU & EJBX-4 SS CORTEM enclosure:
Standard version (STD) -20°C...+55°C

Low ambient temperature (LTA) -50°C...+55°C

ATEX CXJ 12188 ALU AKRON enclosure: 
Low ambient temperature (LTA) -55°C / -50°C...+55°C

Circuit Parameters

Power supply (L+, PE, L-) 24 VDC +10%/-15% (max. 40V)

Intrinsically safe multiplexer circuit of signal 
converter

Uo = 6.51 V

Io = 208 mA

Lo = 1.5 mH

Co = 22 μF

Po = 0.34 W

PT100 circuit between flow sensor and signal 
converter

Uo = 4.91 V

Io = 5 mA

Lo = 100 mH

Co = 100 μF

Po = 10 mW
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3.1  Notes on installation

3.2  Storage

Correct storage position

Storage conditions
Maintain the following storage conditions to prevent the equipment from corrosion or early 
failure:

• Humidity: <95 % RH (closed and heated storage area)
• Storage temperature: -40...+65º C / -40...+149º F
• Avoid direct solar radiation during long storage periods, store under a sunshade

CAUTION!
Inspect the packaging carefully for damages or signs of rough handling. Report damage to the 
carrier and to the local office of the manufacturer.

INFORMATION!
Do a check of the packing list to make sure that you have all the elements given in the order.

INFORMATION!
Look at the device nameplate to ensure that the device is delivered according to your order. 
Check for the correct supply voltage printed on the nameplate.

Figure 3-1: Storage

1  DN100...200 / 4...8": Put flow sensor on the housing.
2  DN250...600 / 10...24": Put flow sensor on supports.
3  DN250...600 / 10...24": Make sure that the flow sensor is always on the supports.

WARNING!
Make sure that the extensions on the bottom of the flanges are in good order to prevent the flow 
sensor from rolling over. Otherwise take appropriate measures to prevent the meter from 
rolling over.
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How to prevent corrosion
For carbon steel flow sensors / pipes, pay attention to the conservation of the inner pipe wall:

1. For a storage period of less than one year, the inner pipewall of flow sensors and additional de-
livered piping such as inlets and outlets should be protected by a corrosion inhibitor such as 
Shell Ensys.

2. For a period of one year or longer, the pipewall of the flow sensor and other piping should be 
protected by Tectyl or a similar product.

3.3  Transport

3.4  Pre-installation requirements

WARNING!
• Even smaller size flow sensors have a considerable weight. Check the weight of your flow 

sensor in order to select suitable means for transportation and lifting.
• Use appropriate materials such as chains or hoisting straps that are in good condition.
• Use the eye bolts on the flow sensor body to attach chains or straps to lift the flow sensor (if 

not present: check the condition of the threaded holes on the flanges and if ok, then install 
eye bolts in the threaded holes).

• Verify local safety regulations, directives and company procedures with respect to hoisting, 
rigging and transportation of (heavy) equipment.

INFORMATION!
The equipment is designed for safe operation under the following conditions:
• Humidity: < 95% RH
• Ambient temperature: -55...+55°C / -67...+131°F
• Suitable for indoor and outdoor use.
• IP66 / NEMA 4X classification.
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3.5  Installation

3.5.1  Mounting position

3.5.2  Pipe diameters

Ensure that the inner diameter of the upstream pipe matches the specified connection diameter 
at the flange of the ultrasonic flow sensor within 1%. Contact the manufacturer if the inner 
diameter deviates more than 1%.
The inner diameter of the downstream pipe must be within 3% of the flow sensor. 

3.5.3  Flow conditioners

An additional flow conditioner can be installed upstream of the flow sensor to minimize the 
influence of upstream perturbations.

CAUTION!
• Install the flow sensor in a horizontal position with the flow arrow indicator on the flow 

sensor in the direction of the positive (forward) liquid flow.
• Do not install the flow sensor at the highest position in the pipe line.
• Check the weight of the flow sensor. Typically the weight of the flow sensor will be 

considerably more than the same length of pipe line. To support the flow sensor additional 
supports might be needed, preferably on each side of the flow sensor.

• If supports can not be placed under the flow sensor flanges, supports may be placed under 
the mating flanges of the pipeline. If supports can only be placed under the pipeline sections 
upstream or downstream of the flow sensor, these supports shall be as close as possible to 
the flow sensor. In this case a calculation shall be made to verify that the load on the pipeline 
will not exceed acceptable values.

• The flow sensor should be installed in the pipeline with gaskets, nuts and bolts according to 
the type and size of the flanges of the flow sensor. The flanges of the flow sensor should 
match the flanges of the pipeline where the flow sensor is installed.

• Make sure that the gaskets do not protrude into the flow as this can reduce the accuracy of 
the flow sensor.

• The distance between the flanges should be equal to the length of the flow sensor plus 
gaskets. No excessive force should be necessary to tighten the gaps on either side of the flow 
sensor.

• For tightening the bolts of the flanges, apply a lubricant as required, in accordance with the 
materials as used and applicable standards.

• Tighten the bolts of the flanges with a torque according to the standards applicable to the 
flanges and materials used.

CAUTION!
The welds must be grinded to avoid flow disturbances.

CAUTION!
If a flow conditioner is used, it is advised that the flow conditioner, the inlet pipe and the flow 
sensor are calibrated together.
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3.5.4  Inlet and outlet

CAUTION!
The inlet and outlet configurations mentioned are intended as general guidelines.

With flow conditioner for unidirectional use

Figure 3-2: Required straight lengths for inlet and outlet

1  Inlet section before flow conditioner: 5 DN
2  Flow conditioner
3  Inlet section after flow conditioner: 5 DN
4  Outlet section: 3 DN

INFORMATION!
Please note that more straight inlet length will improve overall performance.

With flow conditioner for bidirectional use

Figure 3-3: Required straight lengths for inlet and outlet

1  Section before / after flow conditioner: 5 DN
2  Flow conditioner
3  Section after / before flow conditioner: 5 DN

Without flow conditioner

Figure 3-4: Required straight lengths for inlet and outlet

CAUTION!
For applications without flow conditioner, the inlet and outlet lengths depend on the upstream 
piping arrangement and the liquid conditions (temperature, viscosity, flow rate). Please contact 
KROHNE for assistance.
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3.5.5  Mounting position

3.5.6  Support of the flow sensor

Figure 3-5: Mounting position

Figure 3-6: Support of flow sensor

1  Preferred position of supports under flanges of flow sensor
2  If preferred position is not possible, then use the mating flanges to support the flow sensor
3  If both flanges can not be used, then put the supports under the pipeline as close to the flow sensor as possible.
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3.5.7  Flange deviation

3.5.8  Special considerations

CAUTION!
Max. permissible deviation of pipe flange faces: 
Lmax - Lmin ≤ 0.5 mm / 0.02"

Figure 3-7: Flange deviation

1  Lmax
2  Lmin

Figure 3-8: No installation at highest point

CAUTION!
Do not install the flow sensor at the highest point, because air can collect there.
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3.5.9  Air venting

Figure 3-9: No installation in vertical line before free discharge

CAUTION!
Do not install the flow sensor in a vertical line, because it is not sure that the pipe remains fully 
filled and / or is without vapour.

Figure 3-10: Air venting

1  ≥ 5 m
2  Air ventilation point
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3.5.10  Pressure and temperature sensors

Figure 3-11: Location of pressure and temperature transmitters

1  Install the pressure transmitter downstream of the flow sensor
2  Install temperature transmitter at minimum 3 DN downstream of the flow sensor

CAUTION!
If a bi-directional flow is used, then install the temperature transmitter at a distance of 10 DN of 
the flow sensor.
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3.6  Backpressure

To prevent flashing / cavitation in the flow sensor, it should be installed in such a way that the 
flow sensor is always fully filled and has enough back pressure. As a guide line, the pressure 
should not go below the minimum limit as shown in the following graph.

To calculate the minimum required pressure in the pipeline to avoid flashing, you have to know 
the vapour pressure of the process liquid and add it to the pressure, found in the next figure.

Example for crude oil, at velocity of 10 m/s: Example for crude oil, at velocity of 10 m/s: Example for crude oil, at velocity of 10 m/s: Example for crude oil, at velocity of 10 m/s: 
1 In technical documentation, find the vapour pressure Pv of crude oil. This is 0.7 bar(a). 
2 In the figure above, find the ΔP value at 10 m/s. This ΔP value is 1.8 bar.
3 Calculate the minimum required pressure P P P Pminminminmin = Pv +  ΔP. This will result in 0.7 + 1.8 = 2.5 bar 
as a minimum pressure for the pipe line.

Figure 3-12: Needed pressure above vapour pressure

1  ΔP [bar]
2  Velocity [m/s]

Figure 3-13: Needed pressure above vapour pressure

1  ΔP [psi]
2  Velocity [ft/s]
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3.6.1  Open discharge

3.6.2  Control valve

3.6.3  Pump

INFORMATION!
Note that with open discharge, there is almost no back pressure, so this can only be used at 
relatively low flows of 3...5 m/s. See also next paragraph to gain more back pressure.

Figure 3-14: Installation in front of an open discharge

Figure 3-15: Installation in front of a control valve

INFORMATION!
Downstream of a valve there is low pressure and high flow disturbance. Therefore it is best 
practice to install the control valve downstream of the flow sensor. 

Figure 3-16: Installation behind a pump

INFORMATION!
Upstream of the pump, there is suction which leads to low pressure. Downstream of the pump, 
the line is pressurised.
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3.7  Sunshades

Figure 3-17: Temperatures

1  Ambient temperature
2  Process temperature
3  Use a sunshade to protect the flowmeter against direct solar radiation

CAUTION!
Direct solar radiation causes temperature gradients in the metering section and must be 
avoided as much as possible. Use a sunshade or canopy to protect the flowmeter and the 
pressure and temperature transmitters against direct sunshine. Another option is to thermally 
insulate the complete metering section including the transmitters.
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4.1  Safety instructions

DANGER!
All work on the electrical connections may only be carried out with the power disconnected. Take 
note of the voltage data on the nameplate!

DANGER!
Observe the national regulations for electrical installations!

WARNING!
Observe without fail the local occupational health and safety regulations. Any work done on the 
electrical components of the measuring device may only be carried out by properly trained 
specialists.

INFORMATION!
Look at the device nameplate to ensure that the device is delivered according to your order. 
Check for the correct supply voltage printed on the nameplate.

DANGER!
For DIV1 installations, cables must be used that are resistant to high temperatures. 
For all other applications, cable must be used that are resistant to high temperatures if the 
process temperature is 65°C (149°F) or higher.

DANGER!
For the flow sensor and the signal converter that are used in a potentially explosive atmosphere, 
obey the following rules: 
• If the device is used in category 2G, certified cable entry devices MUST be used.
• Unused openings MUST be closed with certified closing elements.
• To avoid voltage and current addition, the intrinsically safe circuits must be separated and 

wired to EN 60079-14.
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4.2  Overview of electrical installation

An overview of a typical connection diagram is shown below.

Figure 4-1: Overview electrical connections

1  Signal converter

2  Equipotential bonding wire (> 4 mm2)
3  Flow sensor
4  Connection of body temperature (supplied with delivery)
5  Connection of three signal cables of flow sensor (supplied with delivery)
6  Power supply
7  Pressure and / or temperature transmitters (optional)
8  Display (optional)
9  Flow computer (optional) via:

- RS485, MODBUS
- Pulse / frequency
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4.3  Opening the covers

Before opening:
• Make absolutely sure that there is no explosion hazard!
• Make sure that all connecting cables are safely isolated from all external sources!
• Allow the electronics to de-energize before opening the electronics compartment of the 

signal converter housing. Wait at least 30 minutes for T6...T4 before opening.

4.3.1  Flow sensor

The connection box of the flow sensor can be opened to make all electrical connections. Before 
start-up of the flowmeter, a notified body has to seal it, after which it can not be opened 
anymore.
The side panels of the flow sensor are equipped with a sealing device to prevent unauthorized 
opening and removal of the cover.

4.3.2  Signal converter

The lid of the signal converter is equipped with a sealing device to prevent unauthorized opening 
and removal of the lid.

WARNING!
the following instructions must always be carefully followed, if the housing of the signal 
converter has to be opened respectively closed again.

WARNING!
• In order to prevent unauthorized opening of the converter lid, a sealing device is provided. 

Before a lid can be opened, release this sealing device.
• The bottom of the converter housing provides an earthing point, this must be connected to the 

nearest safety earth conductor.
• Only open the converter housing one minute after the power has been switched off and after it 

has been verified that there is no risk due to the presence of potentially explosive gas.
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4.4  How to use the cable glands

DANGER!
The cable glands in this device have a safety function for hazardous areas. Make sure that they 
are used in the correct way.

CAUTION!
Three different types of cable glands are used. Make sure that the correct cable gland is used for 
the specific cable. 

INFORMATION!
Three different types of cable glands that are used. However, the way of working is very simular 
for all types.

Figure 4-2: Preparation of cable and installation

1  Strip cable, make sure that 20 mm / 0.78" of shielding is available.
2  Back nut
3  Mid cap
4  Clamp
5  Cone
6  Compression nut
7  Washer
8  Entry body
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Figure 4-3: Put the shielding, the cone and the clamp in position

1  Slide the cone under the shielding.
2  Slide the clamp over the shielding.

CAUTION!
Make sure that the shielding makes a good electrical contact with the cone and the clamp to 
ensure a good EMC shielding. A bad electrical contact could lead to reduced measurement 
accuracy.

Figure 4-4: Tighten the mid cap

1  Hand tighten the mid cap.
2  Use a wrench to tighten the mid cap one 360° turn.
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Figure 4-5: Visual check of position of clamp

1  Untighten the mid cap.
2  Check if the shielding is clamped securely.

Figure 4-6: Tighten the compression nut

1  Hand tighten the compression nut.
2  Use a wrench to tighten the compression nut 2.5...3.5 turns.

Figure 4-7: Tighten the mid cap

1  Hand tighten the mid cap.
2  Use a wrench to tighten the mid cap one 360° turn.
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4.5  Flow sensor connections

Figure 4-8: Tighten the back nut

1  Hand tighten the back nut.
2  Use a wrench to tighten the back nut one 360° turn.

INFORMATION!
Use the reverse order if the cables must be loosened from the cable glands.

Figure 4-9: Location of cable glands

1  Front side of the flow sensor
2  Back side of the flow sensor
3  Cable entry for the PT100 cable
4  Cable entry for the signal cables

Figure 4-10: Removal of cover

1  Loosening of screws to remove the cover
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Use the factory supplied sensor signal cables sensor signal cables sensor signal cables sensor signal cables to make the electrical connection between the flow 
sensor and the signal converter.
Each cable has six coaxial cables with pre-assembled SMB conectors. Lead the cable through 
the cable gland and connect it to terminal strip X1 as shown. All cables are numbered in the 
same way as the connector. Three cables are supplied, which means that two of the pre-
assembled coax cables with SMB connectors will not be used.

Use the factory supplied PT100 cable  PT100 cable  PT100 cable  PT100 cable to make the electrical connection between the flow sensor 
and the signal converter. Connect the numbered wires of the cable to terminal strip X2 with the 
same numbers.
This cable has four wires for temperature measurement. Feed the cable through the cable entry 
and connect it as shown. All wires are numbered in the same way as connector X2.

Figure 4-11: Electrical connections of flow sensor

1  Terminal strip X1 for sensor signal cables.
2  Terminal strip X2 for PT100 cable.

F1

S1
S2
F2
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4.6  Signal converter connections

DANGER!
For the flow sensor and the signal converter that are used in a potentially explosive atmosphere, 
obey the following rules: 
• If the device is used in category 2G, certified cable entry devices MUST be used.
• Unused openings MUST be closed with certified closing elements.
• To avoid voltage and current addition, the intrinsically safe circuits must be separated and 

wired to EN 60079-14.

Figure 4-12: Location of cable glands

Number in Figure Cable entry Connection

1 PT100 cable, included in delivery  refer to Multiplexer board (MUX) 
connections on page 40

2 Sensor signal cable, included in 
delivery

 refer to Multiplexer board (MUX) 
connections on page 40

3 Power supply cable, not included 
in delivery

 refer to Power Supply Board 
(PSB) on page 52

4 Optional power supply cable for 
heating

-

5 I/O connections  refer to Smart IO board (SMART 
IO) connections on page 42

DANGER!
Make absolutely sure that only certified cable glands, shielded cables and blind plugs are 
installed!
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4.6.1  Multiplexer board (MUX) connections

The sensors and the body temperature sensor are connected to the MUX.

Use the factory supplied sensor signal cables sensor signal cables sensor signal cables sensor signal cables to make the electrical connection between the flow 
sensor and the signal converter.
Each cable has six coaxial cables with pre-assembled SMB connectors. Lead the cable through 
the cable gland and connect it to the card as shown. All cables are numbered in the same way as 
the connector. Three cables are supplied, which means that two of the pre-assembled coax 
cables with SMB connectors will not be used.

Use the factory supplied PT100 cable  PT100 cable  PT100 cable  PT100 cable to make the electrical connection between the flow sensor 
and the signal converter. Connect the numbered wires of the cable to the connector with the 
same numbers.

Figure 4-13: Multiplexer

1  Connections for body temperature correction
2  Connections of transducers of flow sensor

INFORMATION!
The GND terminal is not used, do not connect it.
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4.6.2  Monitoring Configuration and Diagnostics (MCD) board connections

The MCD board contains the log file on an SD card as well as the configuration stored on an 
internal flash memory. TCP/IP can be used as Modbus over TCP/IP.

Figure 4-14: ALTOSONIC 5 MCD board

1  Status lights, from left to right:
Red status 1
Red status 2
Green MCD power supply OK

2  Ethernet connection 10/100 Mb
3  USB (only for service purposes by KROHNE service engineers)
4  mini USB (only for service purposes by KROHNE service engineers)
5  mini USB for configuration tool
6  SD card

Figure 4-15: Ethernet RJ45 connector pin 1...8

RJ45 Ethernet 
connection pin

Wire color (T568A) Wire color (T568B) Function

1 white/green white/orange Transmit +

2 green orange Transmit -

3 white/orange white/green Receive +

4 blue blue Not used

5 white/blue white/blue Not used

6 orange green Receive -

7 white/brown white/brown Not used

8 brown brown Not used
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4.6.3  Smart IO board (SMART IO) connections

The SMART IO board has multiple configurable IO's. The smart IO's can be configured either as 
digital input/output or analog input/output. All functions use the same connections. The function 
is defined by the chosen configuration.

Status lights for each channel

Figure 4-16: 

1  4x configurable IO connection

Function of LED Meaning

Off Channel is inactive

Slow short blinking Channel not configured

Slow long blinking Normal operation

Fast blinking Channel is configured, but not connected correctly 

Continuous on An error occured

INFORMATION!
• Passive mode: If a passive external device is connected, an external power supply is 

necessary to operate the connected devices (Uext). If an active external device is connected, it 
can be connected directly.

• Active mode: The signal converter supplies the power to operate the connected passive 
devices, observe max. operating data. The maximum quantity of active outputs is limited to 
four.

• Terminals that are not used should not have any conductive connection to other electrically 
conductive parts.
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mA meter
0...20 mA or 4...20 mA and other
RL is the internal resistance of the measuring point including the cable 
resistance

DC voltage source (Uext), external power supply, any connection polarity

DC voltage source (Uext), observe connection polarity according to 
connection diagrams

Internal DC voltage source

Controlled power source

Electronic or electromagnetic counter
At frequencies above 100 Hz, shielded cables must be used to connect the 
counters.
Ri is the internal resistance of the counter

Table 4-1: Description of symbols
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Inputs and outputs
Inputs and outputs can be configured in the MCD tool as described below. The limits of currents 
and voltage can be configured in the MCD per IO. Limitation of these adjustable values are:

• Uint = 3...23 V

• Imax < 25 mA

Active frequency output
The active output can be connected to a passive external instrument.

• Use terminals 'S' (Supply), '+' and '-' 
• R: 1 kΩ (use resistor R to lower the resistance if the value is too high)

Passive frequency output
The passive output can be connected to a passive external device with an external power supply 
or directly to an active device.

• Use terminals '+' and '-'
• Uext ≤ 27 V

Figure 4-17: Frequency output, active

Figure 4-18: Frequency output, passive
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Active digital input
The active digital input can be connected to a passive external device.

• Use terminals 'S' (Supply) and '+' 
• R: 1 kΩ

Passive digital input
The passive input can be connected to a passive external device with an external power supply or 
directly to an active device.

Figure 4-19: Digital input, active

Figure 4-20: Digital input, passive, highside connection
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• Use terminals '+' and '-' 
• Uext ≤ 27 V

Figure 4-21: Digital input, passive, lowside connection
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Active digital output
The active output can be connected to a passive external device.

• Use terminals 'S' (Supply) and '+' 

Passive digital output
The passive output can be connected to a passive external device with an external power supply 
or directly to an active device.

• Use terminals '+' and '-' 
• Uext ≤ 27 V

Figure 4-22: Digital output, active

Figure 4-23: Digital output, passive, highside connection
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Active analog output
The active output can be connected to a passive external device.

• Use terminals 'S' (Supply) and '+'

Figure 4-24: Analog output, active
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Passive analog output
The passive output can be connected to a passive external device with an external power supply 
or directly to an active device.

• Use terminals '+' and '-'
• Uext ≤ 27 V

Figure 4-25: Analog output A, passive

Figure 4-26: Analog output B, passive
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Active analog input
The active input can be connected to a passive external device.

• Use terminals 'S' (Supply) and '+'

Passive analog input
The passive output can be connected to a passive external device with an external power supply 
or directly to an active device.

• Use terminals '+' and '-'
• Umax = 27 V

Figure 4-27: Analog input, active

Figure 4-28: Analog input A, passive

Figure 4-29: Analog input B, passive
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4.6.4  RS485 IO board connections

The RS485 IO board has 4 serial communication channels. These channels are RS485 type of 
communication, the channel can be chosen as being slave or master in the configuration.

Status lights for each channel

All RS485 channels are galvanically isolated. The standard configuration is as follows:

• CH1: Modbus Master
• CH2: Modbus Slave 1
• CH3: Modbus Slave 2
• CH4: Backwards compatible for Ultrasonic Flow Processor ALTOSONIC V

A terminal resistor should be used if the cable is longer than 10 meter and high speed 
communication is used. To connect the termination resistor, a jumper must be set, that can be 
found on the communication board as shown in the next figure.

Figure 4-30: ALTOSONIC 5 RS485 IO board

1  4x RS485 connection
2  8x status LED for RS485 IO board

Function of LED Meaning

Off Channel is inactive

Slow short blinking Channel not configured

Slow long blinking Normal operation

Fast blinking Channel is configured, but not connected correctly 

Continuous on An error occured
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4.6.5  Power Supply Board (PSB)

The PSB supplies isolated power to all cards installed in the signal converter.

Figure 4-31: Jumpers on Communication board

1  I/O connectors that are accessible on the front
2  Jumpers (one for each I/O connector)
3  Multipole connector which connects the PCB to the backplane
4  Jumper is used: channel is terminated
5  Jumper is not used: channel is not terminated (factory default setting)

Figure 4-32: ALTOSONIC 5 PSB board

1  Power Supply connections 24 V DC (+10/-15%)

CAUTION!
Do not switch on the power yet!
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4.6.6  Digital Processor Board (DPB)

The DPB calculates the flow for the flowmeter. This card can be sealed to protect the Custody 
Transfer security of the flowmeter. For more details,  refer to MCD tool on page 57.

4.6.7  Power Supply Board Intrinsically Safe (PSB IS)

This board has only internal connections and serves as a certified EX(i) power supply for the 
intrinsically safe part of the signal converter.

Figure 4-33: ALTOSONIC 5 DPB

1  Status lights:
. Upper row, left to right:
Green FPGA configuration OK
Green internal power OK
Green DPB power supply -6 V OK
Green DPB power supply +6 V OK
. Lower row, left to right: Red status lights

2  Internal service connector (KROHNE purpose only)
3  Debug interface (KROHNE purpose only)
4  Dip switches, from top to bottom:

1: CT parameters. Left position: locked; right-hand position: unlocked
2: Factory test. Must always be in the left position
3: Not used
4: Not used

Figure 4-34: Intrinsically safe power supply

1  4x Power supply ok light
a. +DC/DC ok green
b. -DC/DC ok green
c. +Vmux ok orange
d. -Vmux ok orange
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4.6.8  Analog Processor Board (APB)

The APB is the interface between the Multiplexer and the DPB and is installed in the intrinsically 
safe part of the signal converter.

4.7  Equipotential bonding

• The flow sensor UFS 5, the signal cables, the PT100 cable and the UFC 5 F signal converter 
must all be included in the equipotential bonding system of the hazardous area. If a single 
separate conductor is used for equipotential bonding, then use a cable with a cross section of 
at least 4 mm2 copper.

Figure 4-35: ALTOSONIC 5 Analog Processor Board

1  2x Status led (red):
- Status 1
- Status 2
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5.1  Switching on the power

Before connecting to power, please check that the system has been correctly installed:
• The flowmeter must be installed in  a mechanically safe way and in compliance with the 

regulations.
• All electrical connections must have been made in compliance with the regulations.
• Make sure that there is a switch installed to switch on or off the power.
• The electrical terminal compartments must be closed with the covers.
• Check that the electrical operating specifications of the power supply are correct.
• Make sure that there are no openings in the housing. Any unused cable gland must be 

replaced by a Ex certified blind plug. In addtion, make sure that each cable is tightly 
connected in its cable gland.

•  Switch on the power.
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The flowmeter measures the gross actual volume of the liquid. If necessary, the measured 
volume can be corrected for temperature and pressure with a flow computer. In the illustration 
below a typical set-up is shown with a flow computer and a pressure and temperature 
transmitter. The flow computer has to be set-up in accordance with local regulations.

CAUTION!
The actual gross volume is already compensated for body expansion by temperature. optional is 
also correction for body expansion by pressure. If however the body expansion correction is 
externally applied, the internal correction must be disabled.

Figure 6-1: Correction of flow volume with P&T transmitters and flow computer

1  Flow sensor
2  Signal converter
3  Liquid temperature and pressure transmitter
4  Summit 8800 flow computer

INFORMATION!
Optionally, the density can be measured as well.
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7.1  Introduction

The KROHNE Flowmeter Configuration and Monitoring Tool is a software package to support the 
application of the ALTOSONIC 5  flowmeters. It is designed to be used with a PC with a Windows 
operating system and can be downloaded from www.krohne.com.
It can:  

• collect data from a flowmeter
• present data from a flowmeter
• verify / set / adjust parameters used by the software inside the flowmeter.

The software can be operated using different communication methods such as:

• TCP/IP
• Modbus
• USB

7.2  Installation of the software

After the software has been installed, the Windows Program menu will have an item KROHNE 
Custody Transfer Products with sub item KROHNE Flow Meter Configuration & Monitoring Tool.

7.3  Starting a session

After the program is launched a blank screen will appear with only a number of menu pull down 
buttons on the menu bar on the upper left side of the computer screen.

The lower left corner of the screen shows a status bar with some information fields and status 
fields or status indicators.

CAUTION!
To secure reliable operation of the flowmeter, access is limited by means of passwords. 
Different passwords are available for different user roles.

INFORMATION!
A session is the activity starting with establishing communication (connecting) with a flowmeter. 
A session ends when the communication process with a flowmeter is terminated 
(disconnecting). During a session data can be collected from a flowmeter in order to monitor and 
evaluate the performance, the collected data may be stored as a log file and parameters can be 
adjusted.

Figure 7-1: Start-up screen, upper part
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The first field is an information field, reserved to show the communication method in operation. 
Without an active communication the first and the second fields will show a dash.

When communication with a flowmeter has been established, the second field will show the 
address of this flowmeter, valid for the communication method in operation.

1. Choose and click the menu pull down button Device.
A menu will open with the options Connect, Reconnect and Disconnect.

2. Click Connect (at this time the only valid option).
This will open a dialog box asking to select or confirm the communication method you intend to 
use.

1. Click OK to confirm if you want to select the option as displayed or - if not -
2. Click the down button to have the other options displayed.
3. Select and click the option you need.
4. Click OK to confirm.

KROHNE Flowmeter Configuration and Monitoring Tool will now send a message, asking for a 
response from any flowmeter that is able to communicate using the selected communication 
method.

Figure 7-2: Start-up screen, lower part

Figure 7-3: Connect the device

Figure 7-4: Communication interfaces



 MCD TOOL 7

59

ALTOSONIC 5

www.krohne.com01/2016 - 4004360702 - MA ALTOSONIC 5 en R02

When using TCP/IP (network environment) a dialog box will appear listing the responding 
flowmeters. If multiple instruments are present in the same network a list will be presented.
The other communication option are peer-to-peer and will request for setting up the 
communication link.

An arrow in the most left column in the dialog box marks the meter selected to start a 
communication session.

1. To confirm the selection, click on the arrow in the most left field of the row with the meter se-
lected by default.

2. To select another meter: move the arrow to the row with the flowmeter you want to communi-
catie with, click in the most left field of the row showing the meter. 

3. Confirm the choice by clicking OK.

Figure 7-5: Select the device
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Figure 7-6: Settings for Modbus port 0
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If you do not get a response from any meter or you don’t get a response from the flowmeter you 
want to communicate with, then the reasons can be: 

• there is no flowmeter operational, or
• the flowmeter you want to communicate with is not connected to a power source, or
• the communication line is not properly connected.

   If this happens you can press the button “Rescan” after the problem is solved. MCST will now 
resend the message, asking for a response from any meter that is able to communicate using 
the selected communication method. If the problem has been solved properly, the meter that 
you are looking for will be listed in the dialog box.
You have now selected a communication method and a meter. The selected communication 
method and flowmeter address will now appear in the respective information fields in the status 
bar at the bottom of the screen.

Figure 7-7: Settings for Modbus port1
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Type your name and password in the dialog box and click OK.

Standard:  User: operator  /  Password: operator
or User: supervisor  /  Password: supervisor

 The selected communication method and flowmeter address will appear in the respective 
information fields in the status bar at the bottom of the screen.

Figure 7-8: Selection at the bottom of the screen

Figure 7-9: Login dialog box

Figure 7-10: Status bar information
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7.4  Loading a monitoring configuration

To load a monitoring configuration:

Step 1:Step 1:Step 1:Step 1: Click the button “File” to open the File menu.

Step 2:Step 2:Step 2:Step 2: Select the option “Open Monitoring Configuration”.

A browser window will open.

INFORMATION!
There are two different methods to obtain data from a flowmeter.
• Request information on a specific data item: if it is a parameter the current value will be 

reported, this is a static value. If it is a variable, the value will be reported and updated every 2 
seconds.

• Define a selection of data that the flowmeter will send as a package and update at specific 
rate. This way the data collecting process is customized to collect only those variables or data 
elements that one really needs or wants to be monitored and / or logged (as the meter 
produces a large amount of data it will not be possible to collect and update all the variables 
in a short time interval).

The option “Configure” is available to customize the selection of data to be sent from the 
flowmeter at a specific update rate. This option is used to define the set of data that will be 
collected from the flowmeter: this set of data will be available to be displayed simultaneously. 
The specification of such a set of data is stored in a monitoring configuration file, a file with an 
extension “ .mon ” . A default monitoring configuration file can be found in the software 
installation package. Once a monitoring configuration is loaded, the monitoring process can be 
started and stopped.

Figure 7-11: File menu
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Step 3:Step 3:Step 3:Step 3: Select a monitoring configuration file and click “Open”.

As a start you can select the default monitoring configuration file.
A dialog box will appear, asking whether you want to start the monitoring function now:

Step 4:Step 4:Step 4:Step 4: Click “Yes” to start the monitoring function.

The monitoring status field updates from “Mon.OFF” to “Mon.ON”, and turns from yellow into 
green.

Alternatively you can configure the software to automatically find a monitoring configuration file 
and start monitoring immediately after the program is launched.

Step 5:Step 5:Step 5:Step 5: Click the “Tools” button to open the tools menu.

Figure 7-12: Open monitoring configuration

INFORMATION!
You can create and save one or more monitoring configurations of your own, according to your 
own preferences. Later it will be explained how you can do this.

Figure 7-13: Green status field
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Step 6:Step 6:Step 6:Step 6: Click “Settings”. A window “Settings” with 5 tabbed sheets will open.

Step 7:Step 7:Step 7:Step 7: On the sheet ”Auto start” select the box “Start monitoring after connecting”.

Step 8:Step 8:Step 8:Step 8: You can:

• click the button “Use current configuration”, or
• click “Browse” to open another window This is an identical browse window as used before to 

find a monitoring configuration file. 
Select the file you want to use to start monitoring the next time you connect to a meter.

Step 9:Step 9:Step 9:Step 9: Click “OK” to confirm the settings.

Figure 7-14: Tools menu

Figure 7-15: Settings
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The next time you launch the program the steps 1...4 will be skipped.

7.5  Changing and saving a monitoring configuration

7.5.1  Creating a monitoring configuration

When opening the KROHNE Flowmeter Configuration and Monitoring Tool the default settings 
are such that a default monitoring file is loaded and that a default user view is activated. Also the 
KROHNE Flowmeter Configuration and Monitoring Tool will start logging directly. All these 
features will be discussed in the next paragraphs. If due to unforeseen reasons the default start 
up settings does not start up in the paragraphs below the different steps are discussed to 
activate monitoring, user view and logging.

In order to modify the selection of data available for monitoring, change the monitoring 
configuration.

Step 1:Step 1:Step 1:Step 1: Click the button “Monitoring” to open the monitoring menu.

Step 2:Step 2:Step 2:Step 2: Click the option “Configure…”.

In case a monitoring session is active the message box as below will appear.

Step 3:Step 3:Step 3:Step 3: Click “Yes” to stop the monitoring activity. 

Figure 7-16: Monitoring menu

Figure 7-17: Warning for running session

INFORMATION!
Note that the instrument itself will not stop measuring! Only the presentation of measuring 
results will be interrupted.
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The Monitoring Configuration dialog appears:

Step 4:Step 4:Step 4:Step 4: Click “Edit List” . The Monitoring List editor dialog appears:

Figure 7-18: Monitoring configuration

Figure 7-19: Monitoring list
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Variables can be added to the list of values to be collected from the meter and become available 
for presentation:

Step 5:Step 5:Step 5:Step 5: Open the tree structure in the left panel, and select the variable name to be added to the 
list.

Step 6:Step 6:Step 6:Step 6: Click the button pointing to the right in the center panel. The item will now appear in the 
list in the right panel.

Similarly variables can be deleted from the list of values to be collected from the meter, these 
values will no longer be available for monitoring / logging.

Step 7:Step 7:Step 7:Step 7: In the right panel, click in the box to the left of the name/description of the variable to be 
deleted, the pointer will not move to this line. This will also enable the button in the center panel 
with the arrow pointing to the left.

Step 8:Step 8:Step 8:Step 8: Click on this button to remove the selected item from the list.

Step 9:Step 9:Step 9:Step 9: Click the button in the centre panel with the double arrow to the left to clear the list 
completely.

Step 10:Step 10:Step 10:Step 10: Click the button “Close” in the centre panel to finish this part: Monitoring List editor 
screen will disappear, Returning to the “Monitoring Configuration Window”.

You can adjust the rate at which the selected data will be sent and updated: 

Step 11:Step 11:Step 11:Step 11: Click the “down”- arrow left of “Interval in sec.”

Step 12:Step 12:Step 12:Step 12: Click on the rate according to your preference.

Step 13:Step 13:Step 13:Step 13: Click the “Close” button in the lower right corner of this window to finish this part. A 
dialog box will ask if you want to (re)start the monitoring process.

Figure 7-20: Monitoring configuration
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Step 14:Step 14:Step 14:Step 14: Click “Yes” to resume the monitoring process.

7.5.2  Saving a monitoring configuration with a new name

Step 1:Step 1:Step 1:Step 1: Click the button "File" to open the file menu.

Step 2:Step 2:Step 2:Step 2: Click the menu item “Save Monitoring Configuration As..”.

Figure 7-21: Restart of monitoring

INFORMATION!

• If you want to save both the modified monitoring configuration as well as the monitoring 
configuration you used as a starting point, you will need to save now the modified 
configuration (with a new unique name).

• If you do not save the modified configuration now, the program will prompt you at the time 
you close the program, however at that time you have only two options: you can save the 
configuration used as a starting point (loosing your modifications) or you can save the 
modified configuration, this will overwrite the starting configuration (and the starting 
configuration will be lost).

Figure 7-22: File menu
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Step 3:Step 3:Step 3:Step 3: Type a new name in the box “Filename”. 

Step 4:Step 4:Step 4:Step 4: Click "Save".

Your new monitoring configuration is now saved with its new name.

7.5.3  Saving a monitoring configuration with its current name

You can save an updated version of your monitoring configuration at any time:

Step 1:Step 1:Step 1:Step 1: Click the "File" button to open the file menu.

Step 2:Step 2:Step 2:Step 2: Click “Save Monitoring Configuration”.

The monitoring configuration file used as starting point will now be replaced by the modified 
monitoring configuration.

Figure 7-23: Save monitoring configuration

Figure 7-24: File menu
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7.6  Creating a monitoring configuration

You have to use the option “New Monitoring Configuration…” in the File menu to create a 
monitoring configuration file. 

Step 1:Step 1:Step 1:Step 1: Click the “File” menu button.

Step 2:Step 2:Step 2:Step 2: Click the option “New Monitoring Configuration…”.

You can use this even if you already have a monitoring configuration opened and running. In that 
case you are asked to stop the running monitoring session.

Click “Yes”.

CAUTION!
If you have no monitoring configuration file available to start with, or when you have not yet 
opened a monitoring configuration file, the option “Configure…” in the “Monitoring” menu is not 
available.

Figure 7-25: File menu

Figure 7-26: Warning for running session



7 MCD TOOL 

72 

ALTOSONIC 5

www.krohne.com 01/2016 - 4004360702 - MA ALTOSONIC 5 en R02

Now the Monitoring Configuration screen appears:

Step 3:Step 3:Step 3:Step 3: Click “Edit List”. 

The empty Monitoring List Editor window will appear.

Step 4:Step 4:Step 4:Step 4: Open the tree in the panel to the left of the window, select the data items you want to 
monitor and add these to the list in the panel to the right of the window, by pressing the ">" 
button.

Step 5:Step 5:Step 5:Step 5: When finished, click “Close” in the “Monitoring List Editor” window.

Step 6:Step 6:Step 6:Step 6: Set or adjust the “Fetch Rate” to the value as required.

Step 7:Step 7:Step 7:Step 7: Click “Close” in the “Monitoring Configuration” window.

Figure 7-27: Monitoring configuration
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The “Monitoring” window reappears:

Step 8:Step 8:Step 8:Step 8: Click “Yes” to start the monitoring process.

Store the new monitoring configuration using the “Save…” option in the File menu as described 
before. Assign a name to the new monitoring configuration: the “Save Monitoring Configuration” 
screen will appear.

If you create a new monitoring configuration while an existing monitoring configuration is open: 
at the time you exit the program, you are asked to replace the starting configuration, or you may 
decide not (if you want to keep both you have to use the “Save as…” option before you exit the 
program).

7.7  Viewing data

The easiest way to view data is to open a predefined User Views menu.

1. Click the button View on the menu bar to open the View menu.
2. Click the option User Views to open the User Views window.

This window may contain multiple sheets or tabs. Each tab represents a sheet displaying  a se-
lection of data, in numerical or graphical format (or both).

Figure 7-28: Start monitoring?

Figure 7-29: View menu
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More sheets may be present allowing to present different sets of data or to present data in dif-
ferent formats. A particular sheet is identified by means of its name as is shown on its Tab.

3. In the window User Views, any sheet may be selected by clicking on its associated Tab.
4. Other windows may be selected to be viewed using the View menu.

7.7.1  Unformatted data

Step 1:Step 1:Step 1:Step 1: Click the button “View” on the menu bar to open the “View menu”.

Step 2:Step 2:Step 2:Step 2: Click “Monitoring Data (unformatted)…”.

An information window as below will appear as a scroll list.

The shown data is the data as currently being collected from the meter: only the values of the 
variables as defined in the monitoring configuration file.

Figure 7-30: Unformatted data
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7.8  Customizing the way data is presented

The data presented in “User Views” can be configured according to your specific needs or 
preferences. This applies to the selection of the data and to the way the data is presented: in 
numerical format or as a graph.

7.8.1  Setting up tabs in the user view window

The window “User Views” has two buttons in its lower right corner: “Add Tab” and “Remove Tab”.

Removing a tabRemoving a tabRemoving a tabRemoving a tab

Use the button “Remove Tab” to remove an existing sheet in the window “User Views”. In case the 
“User Views” window has multiple sheets, the currently opened sheet will be deleted.

If you want to keep both the set up you started with and the modified version, save the new 
version with a new name before closing the program. Use the command “Save Monitoring 
Configuration As..” (in File Menu) . This command stores the set up of the information sheets 
contained in “User Views” as well.

Adding / creating a tabAdding / creating a tabAdding / creating a tabAdding / creating a tab

Using the button “Add Tab” you can add a new (empty) sheet in the window “User Views” and 
create a sheet to your own preferences.

A sheet can be set up as one single panel, or split in two sections, arranged as an upper panel 
and a lower panel. Each panel can be used to display data either as a graph or as numerical 
values displayed in cells arranged in a grid.

The name of the file defining the format of the presentation in a specific panel can be read in its 
upper left corner.

INFORMATION!
Only data that is actually gathered from the flowmeter (as set up in the Monitoring 
Configuration), is available to be displayed. A data item not included in the “Fetch list” will not be 
available to be displayed. You have to use the option “Configure” in the “Monitoring” menu to add 
to the “Fetch list” any data item you want to see in order to make it available for presentation. 

INFORMATION!
 in case you made a change, you will be reminded that you changed the monitoring configuration 
file when you close MCST. If you accept the modified configuration file to be saved, you will not be 
able to recover the deleted sheet the next time you start MCST.

INFORMATION!
The format of the way data is presented in a panel is stored in a file with an extension “.grdx” (for 
presenting data as numerical values), “.trdx” (for presenting data as a graph, showing values as a 
trend on a time axis) or “.xygx” (for presenting data as a graph of one variable as a function of 
another variable).
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To add/create a new tab:

Step 1:Step 1:Step 1:Step 1: Click the “Add Tab” button.

Step 2:Step 2:Step 2:Step 2: The “Add Tab” dialogue appears prompting you to enter a name for the sheet and to 
define the data format (graph or numerical) to be used in the upper panel and the lower panel (in 
case only one panel is defined the sheet will have just one panel).

Step 3:Step 3:Step 3:Step 3: Type a name for the new sheet in the box “Tab Name”.

Step 4:Step 4:Step 4:Step 4: Open the selection list for the type of panel you want to use: click the down arrow to the 
right of the box “Type” in the section “Upper Panel”.

CAUTION!
The files used for the preset “User Views” tabs can be reused. This is the easiest way to create 
your own “sheets” or “tabs” : making combinations of the predefined grids and/or graphs 
according to your preference.
In case you use an existing – predefined- format (even if it appeared before as a format filling 
only a half sized upper or lower panel) to fill a sheet or tab with only one panel, it will 
automatically expand to fill the whole of the panel.

Figure 7-31: Add tab
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Step 5:Step 5:Step 5:Step 5: Click “Grid”, “Trend” or “X-Y Graph” according to your choice and then click “OK”.

Step 6:Step 6:Step 6:Step 6: Click the “down” arrow to the right of the box configuration file.

Step 7:Step 7:Step 7:Step 7: A list of available presentation formats will become visible. Click the file of your choice.

Step 8:Step 8:Step 8:Step 8: If desired, select a format and a definition file for the second panel.

Step 9:Step 9:Step 9:Step 9: Click the “OK” button.
Now the new sheet will appear with one or two panels as you have chosen.

7.8.2  Creating a new grid definition

In order to define a “grid” for presentation of data in numerical format according to your own 
preferences:

Step 1:Step 1:Step 1:Step 1: Click “Add Tab”.

Step 2:Step 2:Step 2:Step 2: Type a name for the new tab.

Step 3:Step 3:Step 3:Step 3: Select “Grid”.
Note: Leave the “Configuration File” field empty.

Step 4:Step 4:Step 4:Step 4: Click “OK”.
A new tab defined as a grid will appear initially as a grey area. 

Step 5:Step 5:Step 5:Step 5: In order to have a visible grid displayed, the size of the grid (number of cells) has to be 
defined. With a right mouse click a menu will open, click the option “Add Column(s)”:

Figure 7-32: Add tab

INFORMATION!
As you have added a new tab, you will be reminded you have changed the monitoring 
configuration file when MCST is closed (shut down). If you accept the modified configuration file 
to be saved, you will not be able to recover the monitoring configuration you started with.
If you want to keep both the set up you started with and the modified version, you have to save the 
new version with a new name before closing the program. Use the command “Save Monitoring 
Configuration As..” (in the File Menu) . This command stores the set up of the information sheets 
contained in “User Views” as well.



7 MCD TOOL 

78 

ALTOSONIC 5

www.krohne.com 01/2016 - 4004360702 - MA ALTOSONIC 5 en R02

Step 6:Step 6:Step 6:Step 6: Enter the number of columns in the dialogue box that appears and click OK.

Step 7:Step 7:Step 7:Step 7: Click again in the gray area with the right mouse button to open the context menu, and 
click the option “Add Row(s)”.

Step 8:Step 8:Step 8:Step 8: Type the number of rows in the dialogue box that appears and click OK.

Figure 7-33: Add columns

Figure 7-34: Add columns

Figure 7-35: Add Rows
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The size of the grid is now defined, however it can be adjusted at any time adding columns or 
rows.

To define the information to be displayed by a specific cell:To define the information to be displayed by a specific cell:To define the information to be displayed by a specific cell:To define the information to be displayed by a specific cell:

Step 1:Step 1:Step 1:Step 1: Position the cursor on the cell to be defined. 

Step 2:Step 2:Step 2:Step 2: Click the desired cell with a click of the left mouse button.

Step 3:Step 3:Step 3:Step 3: Open a menu with a right mouse click.

Step 4:Step 4:Step 4:Step 4: Click “Cell Content…”.
In the dialogue box that appears, for the field “Cell Content Type”.

Step 5:Step 5:Step 5:Step 5: Click “down” to open the value list to display the options:
“Empty” / “User Text” / “Process Value Property”.

Step 6:Step 6:Step 6:Step 6: Click “Process Value Property” .

Step 7:Step 7:Step 7:Step 7: For the field “Process Variable” open the variable list .

Step 8:Step 8:Step 8:Step 8: Click the variable to be displayed.

Step 9:Step 9:Step 9:Step 9: For the field “Subitem” open the variable list.
Subitem is the array index for a variable defined as an array.

Step 10:Step 10:Step 10:Step 10: Click the index of the array element to be displayed.

Figure 7-36: Add rows

INFORMATION!
Do not forget the next step! If you skip the cell selection and continue with the following steps 
you might edit the content or format a cell you don't want to change.

INFORMATION!
Steps 6...8Steps 6...8Steps 6...8Steps 6...8 can be done in two ways. After "Step 13" you find an alternative way.
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Step 11:Step 11:Step 11:Step 11: For the box referenced as “Property”, open the list to show the properties that can be 
selected:
Label / Fieldname / Name / Full path / Parent name / Full parent path / Actual value / Average 
value / Minimum value / Maximum value / Unit / Status.

Step 12:Step 12:Step 12:Step 12: Click the property to be displayed.

Step 13:Step 13:Step 13:Step 13: Click ”OK”.

Alternative way for steps 6...8:Alternative way for steps 6...8:Alternative way for steps 6...8:Alternative way for steps 6...8:

Step 6:Step 6:Step 6:Step 6: Click “User text”.

Step 7:Step 7:Step 7:Step 7: Type the text "String" to be displayed in the cell in the field “User text”.

Step 8:Step 8:Step 8:Step 8: Click ”OK”.

To adjust the appearance of a cell and its content:To adjust the appearance of a cell and its content:To adjust the appearance of a cell and its content:To adjust the appearance of a cell and its content:

Step 1:Step 1:Step 1:Step 1: Position the cursor on the cell to be defined. 

Step 2:Step 2:Step 2:Step 2: Click this cell with a click of the left mouse button.

Step 3:Step 3:Step 3:Step 3: Open a menu with a right mouse click.

Step 4:Step 4:Step 4:Step 4: Click “Cell Properties…”.

Continue to specify the content of any cell as you like.

Right click with your mouse in the area of the panel with the new grid to open the menu.
Click “Save…” or “Save as…” to open a dialog box to enter a name for the grid definition you just 
created. 
Click the “Save” button to finish. 

INFORMATION!
As you have added a tab with a new grid definition, you will be reminded you have changed the 
monitoring configuration file when MCST is being closed (shut down). If you accept the modified 
configuration file to be saved, you will not be able to recover the monitoring configuration you 
started with.
If you want to keep both the set up you started with and the modified version, you have to save the 
new version with a new name before closing the program. Use the command “Save Monitoring 
Configuration As..” (in File Menu) . This command stores the set up of the information sheets 
contained in “User Views” as well. 



 MCD TOOL 7

81

ALTOSONIC 5

www.krohne.com01/2016 - 4004360702 - MA ALTOSONIC 5 en R02

7.8.3  Creating a new graphical presentation

Step 1:Step 1:Step 1:Step 1: Click “Add Tab”.

Step 2:Step 2:Step 2:Step 2: Type a name for the new tab.

Step 3:Step 3:Step 3:Step 3: In the box “Type” click on the option “Trend”.
Note: Leave the “Configuration File” field empty.

Step 4:Step 4:Step 4:Step 4: Click “OK”.
An empty graphic screen appears.

Step 5:Step 5:Step 5:Step 5: Click the button “Configure”.
A window will open for defining the settings of the graphical presentation.

Step 1:Step 1:Step 1:Step 1: Set the number of variables you want to be displayed (each variable selected for being 
displayed is called a “profile”).

Step 2:Step 2:Step 2:Step 2: Set the number of Y-axis’s you will need to represent the values of the variables (profiles) 
you want to be displayed. This number can not be larger than the number of profiles.

Step 3:Step 3:Step 3:Step 3: Set how many stacks you need. A stack is a chart area with its own X and Y axis’s. The 
height of area in the graphical window will be spit in sections, each section will accommodate 
one “Stack”. The number of stacks can not be larger than the number of Y-Axis’.

Step 4:Step 4:Step 4:Step 4: Set the number of Y-scales you will need on the first (upper) stack.

Step 5:Step 5:Step 5:Step 5: Enter this number in the tab Y-Stacks/Y-Stack0.
Do the same for any subsequent “stack”.

Step 6:Step 6:Step 6:Step 6: In the tab “Profile – Process Value Mapping” specify the process value to be represented 
by each profile.

Step 7:Step 7:Step 7:Step 7: In the tab “Profiles” set the axis to be used for displaying the value of each profile.

Step 8:Step 8:Step 8:Step 8: Adjust colours and line/marker styles according to your taste.

Step 9:Step 9:Step 9:Step 9: Click “OK” .

Step 10:Step 10:Step 10:Step 10: Click “Save As”.
Enter a name for the graphical presentation you just have created.

Step 11:Step 11:Step 11:Step 11: Click “Save”.

INFORMATION!
It is beyond the scope of this manual to give detailed instructions about how to define the 
graphical presentation. However you will be able to find your own way using the brief description 
of the next steps:
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7.9  Creating reports

The service tool has been developed to also enable you to create records regarding the state of 
the ultrasonic flowmeter and the way the meter performs. Records can be printed reports or 
records can be exported and saved as data files on a storage medium.

Records can be created regarding:

• the actual parameter values as present in the meter, governing the performance and 
functionality of the meter.

• process values as observed at a specific instant.
• the Modbus address mapping regarding the parameters and process values that can be 

retrieved from the meter using Modbus register addressing.
• rights and/or restrictions regarding access to the ultrasonic meter and the functionality of 

this service tool, as is available for a user of a specific category (such as operator, supervisor, 
calibrator, service technician or factory authorized support engineer). 

To obtain a report:

Click “Reporting” to open the Reporting submenu.

Figure 7-37: Reporting menu
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7.9.1  Reporting related to parameter settings

Click “Parameters” to open a window in which all parameters are listed. 

Use the scroll bar at the right side of the window to scroll through the list and the scroll bar at 
the bottom to display the columns you are interested in.

Creating a formatted reportCreating a formatted reportCreating a formatted reportCreating a formatted report

Go to "Reports & Exports > Reports > Standard parameter report".

Figure 7-38: Parameters

Figure 7-39: Parameter report



7 MCD TOOL 

84 

ALTOSONIC 5

www.krohne.com 01/2016 - 4004360702 - MA ALTOSONIC 5 en R02

A formatted preview of the Standard Parameter Report will be displayed:

As this report will occupy several pages you can use the buttons on top of the screen to select a 
particular page.

The small panel at the left side lists – as a tree structure - all the items included in the report. 
You can use the scroll bar in the right of the small panel to position immediately the report page 
where this parameter is printed in front in the right panel. You can click the highlighted “tree” 
icon to remove this “tree” panel, click again to let it reappear.

Printing a formatted reportPrinting a formatted reportPrinting a formatted reportPrinting a formatted report

Click the button with the printer icon in the upper left of the window to get a printed copy of the 
report.

Figure 7-40: Preview of report

Figure 7-41: Report preview
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Exporting a formatted reportExporting a formatted reportExporting a formatted reportExporting a formatted report

Open the Report Preview’s Export menu:

Select the application format of the exported report: Adobe Acrobat (.pdf), Microsoft Excel (.xls), 
or Microsoft Word (.doc). use the file selector dialogue to select the location and the filename for 
the export.

Create a file listing the parameters in CSV formatCreate a file listing the parameters in CSV formatCreate a file listing the parameters in CSV formatCreate a file listing the parameters in CSV format

Click “Reporting” to open the Reporting submenu.

Click “Parameters” to open a window in which all parameters are listed.

Click “Reports and Exports”, then “Export to CSV…”.

A window opens that allows you to make a selection of the attributes to be listed for each 
parameter.
Select the items you want to include in the exported file.

Figure 7-42: Report preview

Figure 7-43: Parameter overview
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Click the button “Export”.
In the output dialog box that appears:
Specify the location where you want to store the file.
Type a unique file name for the document.
Click the button “Save”.

Saving a parameter file in .XML formatSaving a parameter file in .XML formatSaving a parameter file in .XML formatSaving a parameter file in .XML format

Saving and storing the parameter file as in .XML format is an important feature. In case of the 
unexpected event of a problem, you may need the file in this format to reload the parameters in 
the processor of the ultrasonic liquid flowmeter, for example after replacing the electronic unit.
In order to store the parameter list in .XML format:

• Click Reporting to open the Reporting submenu.
• Click Parameters to open a window in which all parameters are listed.
• Click Reports and Exports.
• Click Export to XML.
• In the window that appears click Export to confirm.
• In the output dialog box that appears: specify the location where you want to store the file.
• Type a unique file name for the document.
• Click the button Save.

Figure 7-44: Export parameter overview
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7.9.2  Reporting related to process values

For the reporting functions related to actual process values the same features and procedures 
are applicable as valid for the parameters.

7.9.3  Reporting related to calibration parameters

The calibration parameters is a subset of the whole collection of parameters. The calibration 
parameters are those parameters that will effect the value of the measuring results. Do not 
modify these parameters after the meter has been calibrated.

For the reporting functions related to calibration parameters the same features and procedures 
are applicable as valid for the parameters.

7.9.4  Reporting related to privileges

For the reporting functions related to privileges the same features and procedures are 
applicable as valid for the parameters.

7.10  Logging data from a flowmeter

After connecting with a flowmeter, the default monitoring configuration file included in the 
“Quick Start” software package will start the logging process automatically. A predefined set of 
data will be collected from the meter and stored as a file on disk.
A field in the status bar at the bottom of the screen will show a field displaying “Log.ON” with a 
green background colour.

In the same field the name of the disk file where the data is stored is displayed between square 
brackets.

When you open the “Monitoring” menu you will observe also a check mark to the left of the option 
“Logging” when data is actually being logged.

Figure 7-45: Monitoring menu
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To stop or interrupt the logging process:To stop or interrupt the logging process:To stop or interrupt the logging process:To stop or interrupt the logging process:

Click the option “Logging”.
The check mark will now disappear, the field in the status bar at the bottom of the screen will 
become yellow and display “Log.OFF”:

To restart the logging process:To restart the logging process:To restart the logging process:To restart the logging process:

Open the “Monitoring” menu.
Click “Logging”.
The check mark will reappear and the status field will display “Log.ON” and turn to green again.
Logged data will be stored in a file for each day (provided it is the same meter).
The software will automatically assign a name to file where the logged data will be stored, the 
date will be part of the file name.
When the logging process is restarted - after it has been interrupted – the new data will be 
appended to the same file as used before (assuming this will happen on the same day).
When a new day breaks a new log file will be created even while a logging process is running.
Logged data will be stored in a file with “.CSV” format.
By default, the file will be stored in the folder:
C:\KrohneData\Logging\MeterModel\Meters\MeterSerialNumber

Some of the actions above or the way the service tool performs depend on specific settings. How 
settings can influence the way the service tool works is explained in the next chapter.

7.11  Customizing the data logging process

As the meter produces a large amount of data, it is not possible to collect all data at a high rate. 
Storing this amount of data would create log files of unpractical sizes.

Decide which data elements have to be collected and stored.

A first selection is already made when defining the set of data selected for the monitoring 
process. The set of data to be saved in a log file on disk must be the same as selected for 
monitoring or a subset thereof. 

Another way to reduce the amount is implemented by means of a setting “Log Rate”. This is 
either the same as the “Fetch Rate” (parameter value equal to 1) or it is a fraction of the “Fetch 
rate” (integer parameter value 2..10). 

Set Set Set Set “Log RateLog RateLog RateLog Rate”

Click “Monitoring” to open the “Monitoring” menu.

Click “Configure…” to open the Monitoring Configuration window.

Figure 7-46: Yellow color of Log.OFF
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Click the down arrow to the right of the box log rate.
Select a value.

Example (as displayed above): When the “Fetch Rate” equals 2, the set of data collected from the 
flowmeter is refreshed every 2 seconds. When the “Log Rate” is set to 5, the fifth of each set of 
data collected from the flowmeter will be stored in the log file. Effectively this means a set of 
data is stored in the log file every 10 seconds. 

Select the data items to be stored in the log file.Select the data items to be stored in the log file.Select the data items to be stored in the log file.Select the data items to be stored in the log file.

In case you want to make changes to the data stored in the log file:

To define or select the data items to be stored in the log file:

Click “Monitoring” to open the “Monitoring” menu.

Click “Configure…” to open the Monitoring Configuration window. 

In the Monitoring Configuration window as above:

Click “Select Items”.

Figure 7-47: Monitoring configuration

INFORMATION!
It is recommended not to decide lightly to make changes to the set of data being stored in a log 
file. The result might be in the .CSV file, and consequently in a related Excel file, specific data 
items will appear in another sequence or in other columns as before. Tools developed for 
processing and analyzing the data in the .CSV file or in the Excel file may no longer work properly 
and as expected. 
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The window “Monitoring List Editor” will open:

The variables listed in the window are the variables selected for being collected for monitoring 
purposes. 

Use the horizontal scroll bar to make the logging-specific columns visible in the window. The 
headers of these columns reads:

• Log Act.
• Log Avg.
• Log Min.
• Log Max.

Select a check mark in any of these columns to indicate which representations of a specific 
variable are included in the logged data.

Figure 7-48: Monitoring List Editor

INFORMATION!
• It is possible to store different representations of any variable: the actual value, the average 

value, the minimum value or the maximum value. 
• Here the average, the minimum and the maximum relate to the number of “Fetches” 

represented by the set of data that is being stored. (A “Fetch” can be regarded as a sample 
including the actual values of all the selected variables at a specific instant.) 

• As an example, this means: in case one set of data is logged every time 5 “Fetches” are 
completed, the “Actual” is one value of that particular variable (the most recent value from 
the values as present in the 5 most recent “Fetches” or samples). 

• “Average” is the average of the values of a particular variable as present in the most recent 5 
samples or “Fetches”. The same applies to “Minimum” and “Maximum”. 
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Missing items in the list of monitored variables can be added here as well:

Step 1:Step 1:Step 1:Step 1: Open the tree structure in the small panel in the left side of the window.

Step 2:Step 2:Step 2:Step 2: Open the folders to the level where individual variable names become visible.

Step 3:Step 3:Step 3:Step 3: (Variables already included in the monitoring list will have a green background colour).

Step 4:Step 4:Step 4:Step 4: Find the variable you want to add in order to be included in the logging.

Step 5:Step 5:Step 5:Step 5: Click on the variable to select it.

Step 6:Step 6:Step 6:Step 6: Click on the button pointing to the right in the panel in the middle.

Step 7:Step 7:Step 7:Step 7: Put check marks in the columns for the representations you want to be logged.

Step 8:Step 8:Step 8:Step 8: Click the Monitoring List Editor’s “Close” button.

Step 9:Step 9:Step 9:Step 9: Click the Monitoring Configuration dialogue’s “Close” button to accept the configuration. 
A confirmation dialogue appears:

Step 10:Step 10:Step 10:Step 10: Click “Yes” to confirm that you want to resume monitoring the flowmeter.

Some more features to customize the logged data fileSome more features to customize the logged data fileSome more features to customize the logged data fileSome more features to customize the logged data file
(In the window “Monitoring configuration”)

Time stampTime stampTime stampTime stamp

The time stamp associated with each data record can be the date and time from the meter itself 
or from your computer system. Select what you want from the value list associated with the box 
“Timestamp with”.

Start Records Start Records Start Records Start Records 

When starting or restarting your logging you can include a record with the names of the fields 
and/or the units used. In the Excel file these will appear as column headers (one row with field 
names and one row with the units used).

Figure 7-49: Monitoring
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Log file size limitationLog file size limitationLog file size limitationLog file size limitation

The size of a log file can be limited either to a maximum number of records or to a maximum 
time span.
In the value list of the box “Switch file based on;” click either

• Duration, or
• Number of records

For Duration, select a time span of:

• 1 hour
• 4 hours
• 12 hours
• 1 day
• 1 week

Click on your choice in the value list associated with the box “ Timespan”. New intervals start at 
multiples of the selected “Timespan”. In case of week the start of a new interval (and the end of 
the previous interval) occurs on the day specified by “Week starts at”.

When using “Number of records”, specify any number of records in the box “Max.Records”. 
However it is not recommended to choose a value over 32767 (which is the maximum number of 
rows that older versions of Microsoft Excel can handle).

Log file nameLog file nameLog file nameLog file name

Date and time are automatically included in the log file name.

Add a prefix of your own choice: for example the name of your company, the name of a site/plant 
or the name of a person.

You can also include the meter model number in the log file name and or include the meter 
serial number. Select or disable the associated boxes. 

It is not recommended to change the extension of the log file name, however if you have good 
reasons to do so it is possible. Just fill three characters according to your choice in the box 
“Extension”.

Storage locationStorage locationStorage locationStorage location

By default the location for storing log files on the hard disk of your computer is:
"C:\KrohneData\Logging".

Dependant of meter model and serial number, subfolders will automatically be created for well 
organized archiving of log files.

You can store you files in another location. For example this can be a drive for centralized 
storage of meter data in a network.

To set the location where you want your data to be stored:
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Step 1:Step 1:Step 1:Step 1: Click the menu button “Tools” to open the Tools menu.

Step 2:Step 2:Step 2:Step 2: Click “Settings…” to open the “Settings” window below:

Step 3:Step 3:Step 3:Step 3:Type in the box “Logging Home Folder” the name (and path) of the directory where you 
want your data to be stored.

7.12  Adjusting parameter settings

A typical adjustment of the parameter setting is the adjustment of the meter factor.
The meter factor is determined during the calibration and is programmed before the ultrasonic 
flowmeter is sealed.
Adjustment of the meter factor for Custody Transfer (CT) applications can only be done under the 
supervision of a calibration officer. A dedicated procedure for calibration adjustment and 
programming the meter is available from KROHNE on request.

7.12.1  Adjusting meter factor

A typical adjustment of the parameter settings is the adjustment of the meter factor. This meter 
factor is determined during calibration and is programmed before the ultrasonic flowmeter is 
sealed.

Adjustment of the meter factor for CT applications can only be done under supervision of a 
calibrating officer.

Step 1:Step 1:Step 1:Step 1: Open the Object Tree Details (from the View menu):

Figure 7-50: Settings

CAUTION!
Only for authorised personnel!
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Step 2:Step 2:Step 2:Step 2: Open the tree by clicking on “+”.

Step 3:Step 3:Step 3:Step 3: Go to “FlowCalculationModule > Configuration > Flow Calcs > MeterConstant_Fwd” (the 
numbering may differ from the example below):

Figure 7-51: View menu

Figure 7-52: Object tree details
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The right side of the screen shows the following information:

Step 4:Step 4:Step 4:Step 4: Enter the meter factor in the “Value” field.

Step 5:Step 5:Step 5:Step 5: Click “Apply”.

Step 6:Step 6:Step 6:Step 6: Click “Save in Flash”.

Wait until the “Writing data to flash disk” pop-up dialogue finishes.

Step 7:Step 7:Step 7:Step 7: Save configuration file to your computer’s disk by clicking on 
File > Save Flowmeter Configuration as XML file.

Figure 7-53: Object tree meter constant

Figure 7-54: Setting meter constant
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7.13  Adjusting the display settings

The display settings can be changed in a few steps.

Step 1:Step 1:Step 1:Step 1: In the "View" menu, open "Parameters per Module...". 

Figure 7-55: File menu
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Step 2:Step 2:Step 2:Step 2: Click on the "+" to open the tree.

Step 3:Step 3:Step 3:Step 3: Select "IO > Displays > Modbus Displays > External Display 1"
(The number can be different)
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Step 4:Step 4:Step 4:Step 4: Set the required settings for the display.

Step 5:Step 5:Step 5:Step 5: Click "Save".
Wait until the "Writing data to flash disk" pop-up dialog completes.

Step 6:Step 6:Step 6:Step 6: Click on "File > Save FlowmeterConfiguration as XML file" to save the configuration file to 
your computer.

Step 7:Step 7:Step 7:Step 7: Select "IO > Displays > Modbus Displays > External Display 1 > Display item 1"
(The number can be different, up to 5 display items can be configured) 

Item Explanation

Unit display duration Time that the unit is displayed.

Name display duration Time that the name is displayed.

Action on item switch Choose whether to start with the name, the unit or 
to continue with a display cycle when a new item is 
shown.

Slow blink on out-of-range The bar blinks slowly when the shown parameter is 
outside the percentage of the indicated limit.

Fast blink on out-of-range The bar blinks fast when the shown parameter is 
outside the percentage of the indicated limit.

Operating Mode Normal mode shows configured items on the 
display test shows the following parameters and 
blinking pattern.

Numeric Part Text Number to be shown on the display during test.

Alpha Part Text Text to be shown on the display during test.

Gauge Test Value Value during test.

Gauge Test Range Low Low range during test.

Gauge Test Range High High range during test.

Gauge Test Usage Choose if bar is used to display value.

Include Zero in Gauge Indicated where the zero of the bar starts, with zero 
or minimum range value during test.

Blink Patterns Blinking pattern used during test.
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Step 8:Step 8:Step 8:Step 8: Set the required settings for the items to display.

Step 9:Step 9:Step 9:Step 9: Click "Save".
Wait until the "Writing data to flash disk" pop-up dialog completes.

Step 10:Step 10:Step 10:Step 10: Click on "File > Save FlowmeterConfiguration as XML file" to save the configuration file 
to your computer.

Item Explanation

Object The parameter to display.

Display name The name for the parameter shown on the display.

Character case for name Indicates how the name is presented (upper case, 
lower case or same as entered)

Character case for unit Indicates how the unit is presented (upper case, 
lower case or same as entered)

Display duration The time the object is displayed.

Gauge usage Indicates the displayed parameter also on the 
gauge bargraph along the edge of the display.

Include Zero in Gauge Determines where the 0% gauge indication starts, 
with Zero or at the minimum scale.
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8.1  Availability of services

The manufacturer offers a range of services to support the customer after expiration of the 
warranty. These include repair, maintenance, technical support and training.

8.2  Returning the device to the manufacturer

8.2.1  Returning the device to the manufacturer

This device has been carefully manufactured and tested. If installed and operated in accordance 
with these operating instructions, it will rarely present any problems.

INFORMATION!
For more precise information, please contact your local sales office.

CAUTION!
Should you nevertheless need to return a device for inspection or repair, please pay strict 
attention to the following points:
• Due to statutory regulations on environmental protection and safeguarding the health and 

safety of our personnel, manufacturer may only handle, test and repair returned devices that 
have been in contact with products without risk to personnel and environment.

• This means that the manufacturer can only service this device if it is accompanied by the 
following certificate (see next section) confirming that the device is safe to handle.

• Use a corrosion protection such as Shell Ensis to avoid corrosion of the inner part of the 
flowmeter and the piping during transport.

CAUTION!
If applicable, send the inlet section and / or flowconditioner together with the flowmeter if the 
flowmeter must be recalibrated. Otherwise, the flowmeter will be less accurate after the 
calibration.
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8.2.2  Form (for copying) to accompany a returned device

8.3  Disposal

CAUTION!
To avoid any risk for our service personel, this form has to be accessible from outside of the 
packaging with the returned device.

Company: Address:

Department: Name:

Tel. no.: Fax no. and/or Email address:

Manufacturer's order no. or serial no.:

The device has been operated with the following medium:

This medium is: radioactive

water-hazardous

toxic

caustic

flammable

We checked that all cavities in the device are free from such substances.

We have flushed out and neutralized all cavities in the device.

We hereby confirm that there is no risk to persons or the environment through any residual media contained in the 
device when it is returned.

Date: Signature:

Stamp:

CAUTION!
Disposal must be carried out in accordance with legislation applicable in your country.

Separate collection of WEEE (Waste Electrical and Electronic Equipment) in the European Union:Separate collection of WEEE (Waste Electrical and Electronic Equipment) in the European Union:Separate collection of WEEE (Waste Electrical and Electronic Equipment) in the European Union:Separate collection of WEEE (Waste Electrical and Electronic Equipment) in the European Union:

According to the directive 2012/19/EU, the monitoring and control instruments marked with the 
WEEE symbol and reaching their end-of-life must not be disposed of with other wastemust not be disposed of with other wastemust not be disposed of with other wastemust not be disposed of with other waste.
The user must dispose of the WEEE to a designated collection point for the recycling of WEEE or 
send them back to our local organisation or authorised representative.
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9.1  Measuring principle

The ultrasonic liquid flowmeter operates according to the principle of measuring  the transit 
time of an ultrasonic sound wave. The liquid velocity is derived from the difference in transit time 
of a sound wave travelling in a direction with the flow direction and the sound wave travelling in 
the opposite direction. The trajectory of the sound wave is called the acoustic path.

9.2  Transit time measuring principle

In a pipe section two transducers A and B create an acoustic path, which in the above figure, is a 
single chord. This chord is the distance between transducer A and B and has a length L. The 
chord intersects with the centre line of the pipe at an angle  ϕ. 
Both transducers are capable to transmit and receive an ultrasonic signal. First, one transducer 
acts as a transmitter and the other as receiver, then the other way around.  The transit time of an 
ultrasonic signal along a measuring chord is influenced by the velocity of the flow (v). If the flow 
is zero the transit time from transducer A to B is exactly the same as the transit time from 
transducer B to A (determined by the speed of sound in the liquid). 
When the liquid flows with a velocity v and with c being the speed of sound in the liquid:
v.cos(ϕ) is the component of velocity in the direction of the measurement chord.

This component increases or decreases the travel time (time of flight of an acoustic waveform)  
as it moves from one transducer to the other transducer. The transit time from transducer A to B 
(tAB) is:

In opposite direction from transducer B to A the transit time (tBA) is:

The velocity of the liquid is derived from formula (1) and (2) as: 

Figure 9-1: Transit time measuring principle

1  Direction of the flow
2  Component of velocity in the direction of the chord
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An important feature of this method is that the calculated velocity does not depend on the speed 
of sound in the liquid or liquid properties in general. The velocity as calculated is only a function 
of the measured transit times tAB and tBA;  the length of the chord and the angle of intersection 
of the measuring chord are supposed to be known from the design of the flowmeter.

As a “bonus” the speed of sound in the liquid can be derived from formula (1) and (2) as : 

This gives a measured speed of sound value, a valuable tool for diagnostic purposes, as it can be 
compared with data from other sources. 
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9.3  Technical data table

INFORMATION!
• The following data is provided for general applications. If you require data that is more 

relevant to your specific application, please contact us or your local sales office.
• Additional information (certificates, special tools, software,...) and complete product 

documentation can be downloaded free of charge from the website (Downloadcenter).

Measuring system
Measuring principle Ultrasonic transit time 

Application range Flow measurement of liquids in custody transfer applications

Versions Standard (STD)

High Viscosity (HV)

Low Temperature (LT)

High Temperature (HT)

Measured value Actual volume flow

Calculated value Totalized flow, velocity of sound

Design
General The ALTOSONIC 5 flowmeter consists of a flow sensor and a signal converter.

Flow sensorFlow sensorFlow sensorFlow sensor

Construction The flow sensor has an eight-path design with a central path for turbulent, 
transition or laminar flow differentation. It also includes a dedicated vertical 
diagnostic path for full pipe guarantee. 

Nominal diameter 4"...24" / DN100...600

Other diameters on request.

Signal converterSignal converterSignal converterSignal converter

Construction The remote flameproof signal converter calculates the volume flow and the 
totalized volume, performs diagnostics and provides data logging 
functionality.

Functionality Calculation of totalised volume

Diagnosis of flow profiles

Body temperature correction

Logging of relevant parameters

Optional display connection
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Measuring accuracy
Measuring range 0...15 m/s (bidirectional)

Reduced bore:Reduced bore:Reduced bore:Reduced bore:

Reynolds range: no limits (turbulent, transition and laminar flow regimes)

Certified for custody transfer: 0.2...15 m/s (bidirectional)

Full bore:Full bore:Full bore:Full bore:

Reynolds range: > 10000

Certified for custody transfer: 0.5...15 m/s (bidirectional)

Linearity 0.10%, for Reynolds range > 10000 with a turndown of 30:1 (0.5...15 m/s)

0.15%, for whole Reynolds range with a turndown of 75:1 (0.2...15 m/s)

Uncertainty < ±0.027% according to API

Repeatability according to API chapter 5.8 table B1

Zero stability < 0.2 mm/s

Certified turndown 75:1

Ambient temperatures
Flow sensorFlow sensorFlow sensorFlow sensor

ATEX, IECEx, 
DIV1/ZONE1

Standard: -20…+65°C / -4…+149°F

Optional: -55…+65°C / -67…+149°F

Storage temperature -40…+65°C / -40…+149°F

Signal converterSignal converterSignal converterSignal converter

ATEX Standard: -20…+55°C / -4…+131°F

Standard + heating:  -50…+55°C / -58…+131°F

Optional: -55…+55°C / -67…+131°F

IECEx Standard: -20…+55°C / -4…+131°F

Standard + heating:  -50…+55°C / -58…+131°F

DIV1 / ZONE1
(C/US)

Standard: -20…+55°C / -4…+131°F

Standard + heating:  -55…+55°C / -67…+131°F

Storage temperature -40…+65°C / -40…+149°F
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Process conditions
Process temperature Standard version: -40...+120°C / -40...+240°F

Low temperature version: -200...+120°C / -328...+240°F

High temperature version: -40...+250°C / -40...+482°F

High viscosity version: -40...+120°C / -40...+240°F

Viscosity range All versions: 0.1...150 cSt

High viscosity version: 0.1...1500 cSt

Pressure range ASME 150...600

Pressure rating according to ASME B16.5 (-29...+38°C / -20...+100°F):

Class 150 lbs: Stainless steel: 19.0 bar / 275 psi

Carbon steel: 19.6 bar / 285 psi

Class 300 lbs: Stainless steel: 49.6 bar / 720 psi

Carbon steel: 51.1 bar / 740 psi

Class 600 lbs: Stainless steel: 99.3 bar / 1440 psi

Carbon steel: 102.1 bar / 1480 psi

Other pressure ranges on request.

Minimum pressure 
requirement

For detailed information,  refer to Backpressure on page 28.

Water content Velocity above 1 m/s: ≤ 6%

Velocity above 2 m/s: ≤ 10%

Solids content < 5% (volume)

Air/gas content < 2% (volume)

Installation conditions
Installation For detailed information,  refer to Mechanical installation on page 20.

Dimensions and weights For detailed information,  refer to Dimensions and weights on page 109.

Altitude < 2000 m

Overvoltage category II

Pollution degree 3

Materials
Flanges (RF) Stainless steel AISI 316 / 316 L (1.4404) (dual certified)

Carbon steel ASTM A105 / A350 Gr.LF2

Other materials / flange types on request

Measuring tube Stainless steel AISI 316 / 316 L (1.4404) (dual certified)

Carbon steel ASTM A105 / A350 Gr.LF2 / A106 Gr.B / A333 Gr.6

Other materials on request

Converter housing Standard: Copper free aluminum

Option: Stainless steel 316 (1.4408)  for offshore applications

Coating Standard: Blasted (not coated)

Option: Epoxy coating RAL 9006 (silver)

Option: Offshore coating RAL 9006 (silver)
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Electrical connections
Power supply 24 VDC +10%/-15%, 4A fuse, internally isolated

Power consumption Standard version: 25...28 W

With optional heater for low ambient temperatures: 24 VDC 175 W

Transducer signals Intrinsically safe flow sensor circuits:

Ui = 18 V, Ii = 210 mA, Ci = 100 nF, Li = 700 µH, Pi = 1 W

Intrinsically safe signal converter circuits:

Uo = 6.51 V, Io = 208 mA, Co = 22 µF,  Lo = 1.5 mH, Po = 0.34 W

PT100 signal Intrinsically safe (ia) circuit:

Ui = 10 V, Ii = 10 mA, Pi = 200 mW

Cable entries Standard: M20 x 1.5

Option: ½" NPT, PF ½

Inputs and outputs
Available options 1x Ethernet

4x RS485 serial Modbus master / slave output

4x (Basic IO) or 8x (optional, extended IO) IO configurable input/output with:
- Digital dual pulse, phase shifted
- Alams
- Analog values 0/4...20 mA inputs/outputs
All circuits: galvanically isolated, rated < 16 V r.m.s. / 22.6 V peak / < 35 VDC

MODBUSMODBUSMODBUSMODBUS

Description Modbus RTU or Modbus ASCII, Slave, RS485 (galvanically isolated)

Transmission procedure Half duplex, asynchronous

Address range 1…247

Supported function 
codes 

03, 04, 06, 08, 16

Supported Baudrate 50, 75. 110, 150, 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 56000, 64000, 
115200, 128000 Baud
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Approvals and certificates
CECECECE

This device fulfills the statutory requirements of the EC directives. 
The manufacturer certifies successful testing of the product by applying the 
CE mark.

Electromagnetic 
compatibility

Directive: 2004/108/EC, NAMUR NE21/04

Harmonized standard: EN 61326-1

Pressure Equipment 
Directive

Directive: 97/23/EC

Category I, II, III

Liquid group 1

Production module H

Hazardous areasHazardous areasHazardous areasHazardous areas

Marking Approval

ATEX Flow sensor II 2G Ex ia IIC T6...T2 Gb FTZU 14 ATEX 0024X

Signal converter II 2G Ex d [ia] IIB T5 Gb FTZU 14 ATEX 0131X

IECEx Flow sensor Ex ia IIC T6...T2 G IECEX FTZU 14 .0020X

Signal converter Ex d [ia] IIB T5 Gb IECEX FTZU 14.0029X

DIV 1 Flow sensor Class I, Groups B, C, D, 
temp class T6…T2

LR 1338-1

Signal converter Class I, Groups B, C, D, 
temp class T5

LR 1338-2

Zone (Canada) Flow sensor Ex ia IIB+H2 T6…T2 Gb LR 1338-1

Signal converter Ex ia IIB+H2 T5 Gb LR 1338-2

Zone, ANSI/ISA (USA) Flow sensor Class I, Zone 1, AEx [ia] 
IIC T6…T2

LR 1338-1

Signal converter Class I, Zone 1, AEx d 
[ia] IIC T5

LR 1338-2

Other approvals and standardsOther approvals and standardsOther approvals and standardsOther approvals and standards

Ingress protection IP66 or NEMA Type 4X

OIML - R117 OIML TC 8548
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9.4  Dimensions and weights

ASME 150 lb

INFORMATION!
• All dimensions are provided as indication. They can vary slightly with different schedule sizes.
• Values for larger diameters are available on request.

Flow sensor

Figure 9-2: Dimensions of flow sensor

Nominal 
size

Metric Imperial

H
[mm]

L
[mm]

W
[mm]

Di
[mm]

Weight
[kg]

H
[inch]

L
[inch]

W
[inch]

Di
[inch]

Weight
[lbs]

4"  / DN100 289 500 330 102.26 175 11.38 19.69 12.99 4.026 385

6" / DN150 340 600 380 154.08 310 13.39 23.62 14.96 6.066 682

8" / DN200 408 600 369 202.74 320 16.06 23.62 14.53 7.982 704

10" / DN250 510 900 450 254.56 230 20.08 35.43 17.72 10.022 506

12" / DN300 530 1000 490 304.74 310 20.87 39.37 19.29 11.998 682

14" / DN350 540 1100 540 336.54 460 21.26 43.31 21.26 13.250 1012

16" / DN400 600 1200 600 387.34 600 23.62 47.24 23.62 15.250 1320

18" / DN450 650 1350 635 437.94 860 25.59 53.15 25.00 17.242 1892

20" / DN500 700 1400 700 482.6 960 27.56 55.12 27.56 19.000 2112

24" / DN600 820 1650 820 584.2 1050 32.28 64.96 32.28 23.000 2310
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ASME 300 lb

ASME 600 lb

Nominal 
size

Metric Imperial

H
[mm]

L
[mm]

W
[mm]

Di
[mm]

Weight
[kg]

H
[inch]

L
[inch]

W
[inch]

Di
[inch]

Weight
[lbs]

4" / DN100 289 500 330 102.26 195 11.38 19.69 12.99 4.026 429

6" / DN150 340 600 380 154.08 325 13.39 23.62 14.96 6.066 715

8" / DN200 396 600 343 202.74 335 15.59 23.62 13.50 7.982 737

10" / DN250 510 950 450 254.56 260 20.08 37.40 17.72 10.022 572

12" / DN300 530 1050 520 304.74 360 20.87 41.34 20.47 11.998 792

14" / DN350 590 1100 590 330.2 440 23.23 43.31 23.23 13.000 968

16" / DN400 650 1200 650 381 690 25.59 47.24 25.59 15.000 1518

18" / DN450 710 1350 710 428.6 900 27.95 53.15 27.95 16.874 1980

20" / DN500 780 1400 780 477.82 1120 30.71 55.12 30.71 18.812 2464

24" / DN600 920 1650 920 574.64 1300 36.22 64.96 36.22 22.624 2860

Nominal 
size

Metric Imperial

H
[mm]

L
[mm]

W
[mm]

Di
[mm]

Weight
[kg]

H
[inch]

L
[inch]

W
[inch]

Di
[inch]

Weight
[lbs]

4" / DN100 289 500 330 102.26 205 11.38 19.69 12.99 4.026 451

6" / DN150 340 600 380 148.36 350 13.39 23.62 14.96 5.762 770

8" / DN200 396 650 343 193.7 370 15.59 25.59 13.50 7.626 814

10" / DN250 510 1000 510 242.92 400 20.08 37.40 20.08 9.564 880

12" / DN300 560 1050 560 288.84 480 22.05 41.34 22.05 11.372 1056

14" / DN350 610 1150 610 317.5 650 24.02 45.28 24.02 12.500 1430

16" / DN400 690 1200 690 363.52 810 27.17 49.21 27.17 14.312 1782

18" / DN450 750 1300 750 409.3 960 29.53 51.18 29.53 16.11 2116

20" / DN500 820 1400 820 455.6 1250 32.28 55.12 32.28 17.94 2756

24" / DN600 940 1600 940 547.7 1910 37.01 62.99 37.01 21.56 4211
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Signal converter housing

9.5  Flow table

Signal converter

Figure 9-3: Dimensions of signal converter housing

Version Metric Imperial

H
[mm]

W
[mm]

D
[mm]

Weight
[kg]

H
[inch]

W
[inch]

D
[inch]

Weight
[lbs]

Aluminium
(standard)

432 332 299 25.4 17.01 13.07 11.77 56.0

Stainless steel
(offshore)

432 382 286 75 17.01 15.04 11.26 165.3

Aluminium (DIV 1
approved)

584 432 292 64 22.92 17.01 11.50 141.1

Nominal size Metric Imperial

Qmin

[m3/h]
0.2 m/s

Qmax
*

[m3/h]
15 m/s

Qmin
[bbl/h]
0.7 ft/s

Qmax
*

[bbl/h]
50 ft/s

4" / DN100 5.6 425 35 2660

6" / DN150 12.6 950 80 5950

8" / DN200 22.6 1700 140 10700

10" / DN250 36 2700 225 17000

12" / DN300 50 3750 315 23500

14" / DN350 70 5250 440 32900

16" / DN400 90 6750 565 42300

18" / DN450 114 8560 715 53750

20" / DN500 140 10500 880 65850

24" / DN600 200 15000 1255 94000

*Ensure that there is enough backpressure to avoid flashing.

Calculations are provided as indication, please ask KROHNE for detailed sizing.
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10.1  Introduction

This chapter describes how to use the Modbus protocol with the flowmeter. Within this chapter, 
the following abbreviations are used for the ALTOSONIC 5 sytem:
UFS-5: Ultrasonic Flow Sensor
UFC-5: Ultrasonic Flow Converter (normally called 'signal converter')

For communication with host systems, the signal converter emulates a Modbus compatible 
controller.
The Modbus protocol defines a message structure that controllers will recognise and use, 
regardless of the type of network over which they communicate. It describes:

• the process that a controller uses to request access to other devices.
• how it will respond to requests from the other devices.
• how errors will be detected and reported.

Controllers communicate is based on the master-slave principle. Only the master can initiate 
transactions (requests), and only the addressed device (slave) responds. In case of a broadcast 
request, none of the slaves will respond.

The Modbus request consists of:

• an address.
• a function code defining the requested action.
• data (if necessary for the requested function).
• an error check for testing the integrity of the message.

The response of the slave contains:

• the slave address.
• data conform the request type.
• an error check.

If the data integrity test fails, no response is sent back. 
If a request can not be processed an exception message is returned.
Maximum total length of the data part is 256 bytes.



 MODBUS PROTOCOL DESCRIPTION AND SET-UP 10

113

ALTOSONIC 5

www.krohne.com01/2016 - 4004360702 - MA ALTOSONIC 5 en R02

10.2  Serial transmission format

Two transmission modes can be used:

• ASCII
•  RTU

The user has to select the desired mode along with the serial communication parameters (baud 
rate, parity).

10.2.1  ASCII mode

Each byte of the message is sent as two ASCII characters (two bytes). This means that only the 
ASCII characters 0-9, A-F are transmitted.

Standard serial communication parameters

The advantage of ASCII mode is that it allows for a time interval up to 1 second between 
characters without causing a timeout. 
A disadvantage of ASCII mode is the larger message length.

INFORMATION!
All parameters must be the same for all controllers in the network.

Start bits 1

Data bits 7

Parity odd/even/none

Stop bits 1 stop bit if parity is used

2 stop bits if no parity is used

Error check 
field

Longitudinal Redundancy Check (LRC)
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10.2.2  RTU mode

Each byte of the message is sent as 8 bits (one byte).

Standard serial communication parameters

Standard serial communication parameters

10.3  Modbus message framing

ASCII mode
In ASCII mode a message starts with a colon character (:) and ends with a carriage return-
linefeed. Intervals up to one second can elapse between characters within the message. If the 
interval is longer, a timeout error occurs and the message is rejected.

RTU mode
In RTU mode a message starts with a silent time interval equivalent to at least 3.5 characters. 
The entire message frame must be transmitted as a continuous stream. If a silent interval of 
more than 3.5 character times occurs before completion of the frame, the receiving device 
flushes the incoming message and assumes that the next byte will be the address field for the 
new message.

For more info about the applied timeout values, .

Start bits 1

Data bits 8

Parity even

Stop bits 1 

Error check 
field

Cyclic Redundancy Check (CRC)

Start bits 1

Data bits 8

Parity even

Stop bits 1 

Error check 
field

Cyclic Redundancy Check (CRC)

Mode Start Address Function Data Checksum End

ASCII-mode : 2 hex 
characters

2 hex 
characters

N*2 hex 
characters

LRC 2 hex 
characters

CR-LF

RTU-mode 3.5 
characters 
silent 
interval

8 bits 8 bits N*8 bits CRC 16 bits 3.5 
character 
silent 
interval

Table 10-1: Example of a typical message frame
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10.3.1  Address Field (Device Address)

The address field of a message frame contains:

Valid slave addresses are 1...247.
Address 0 is used for a broadcast to address all slaves.

10.3.2  Function Field

The function field of a message frame contains:

Valid function codes are 1...127.
The function code tells the slave which kind of action to perform.
For information on the supported functions,  refer to Supported functions on page 116.
A slave response always contains the function code of the request. If a function is not applicable, 
the slave sends an exception response. An exception is indicated by a returned function code 
with bit 8 (most significant bit) set.

10.3.3  Data Field

The data field contains 8 bit values (bytes) in the range of 0 to FF hexadecimal.
In ASCII mode, one datafield (one byte) is made up of two hex characters.

The data field of messages contains information which both master and slave use to perform an 
action. This includes the register address, quantity of registers, and the necessary data.
The endianness will determine which byte contains the most and the least signicant byte. The 
sequence can be determined in the configuration program.

10.3.4  Error checking methods

The contents of the error checking field for the entire message depend on the transmission 
mode.

Error check in ASCII mode transmission
When the ASCII mode is used, the error-checking field contains two ASCII characters. The error 
check characters are the result of a Longitudinal Redundancy Check (LRC) calculation. This is 
performed on the message content with exception of the beginning colon, the carriage return 
and line feed characters. The LRC characters are appended to the message as the last field 
preceding the CR-LF characters.
For more information about the Cyclic Redundancy Check,  refer to CRC codes on page 147.

ASCII mode 2 characters

RTU mode 8 bits

ASCII mode 2 characters

RTU mode 8 bits
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Error check in RTU mode transmission
When the RTU mode is used, the error-checking field contains a 16-bit value implemented as 
two bytes. The error check value is the result of a Cyclic Redundancy Check (CRC) calculation 
performed on the message content. The CRC field is appended to the message as the last field.
For more information about the Cyclic Redundancy Check,  refer to CRC codes on page 147.

10.3.5  Other error checking methods

 Modbus uses two kinds of error checking methods:

• Character based check
An additional parity bit for each character (even or odd parity).

• Message based check
an additional error check calculated over the entire message.

Both character check and message check data is generated in the transmitting device and added 
to the message before transmission. The slave checks validity of each character during receipt 
and the validity of the entire message frame after receipt. The master has a predetermined 
timeout interval before aborting the transaction. This interval should be set long enough for any 
slave to be able to respond.

The timeout interval is set by the parameter 8.1.1.16 Tx time out8.1.1.16 Tx time out8.1.1.16 Tx time out8.1.1.16 Tx time out.

ASCII mode
In ASCII mode the maximum time between 2 characters is one second. If a longer interval 
occurs, the message will be ignored and the search for a starting character (colon) is resumed.

RTU mode
In RTU mode the entire message frame must be transmitted as a continuous stream. If a silent 
interval of more than 3.5 character times occurs before completion of the frame, the receiving 
device ignores the message and assumes the next byte will be the device-address field of a new 
message.

10.4  Physical communication layer

The Modbus protocol is a half-duplex protocol. The physical layer can be half or full duplex.
The Modbus driver supports RS485 and TCP/IP communication layers

10.5  Supported functions

All data addresses in Modbus messages are referenced to zero. For example:

• Coil 1 is addressed as Coil 0001.
• Holding register 40001 is addressed as 40001. Note that the function code specifies the 

operation of a ‘holding register’, therefore the 40000 reference is explicit.

If a function that do not support broadcoast requests, receives an broadcast request, then the 
request will be rejected.
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10.5.1  Function 01: READ COIL STATUS

Description
Function 1 reads the ON/OFF status of discrete inputs or discrete variables in the slave (0 x 
references called coils). Broadcast is not supported.

Query
The query specifies the starting coil and the quantity of coils to read.
The maximum number of coils requested each request is limited to 2000.

Example
Here is an example of a request to read coils 20-56 from slave device 17:

Response

The coil status in the response message is packed as one coil per bit of the data field. Status is 
indicated as 1= ON, 0= OFF.
The LSB of the first data byte contains the coil addressed in the query. The other coils follow 
toward the high order end of this byte and from 'low order to high order' in subsequent bytes.
If the returned coil quantity is not a multiple of eight, the remaining bits in the final data byte will 
be padded with zeros (toward the high order end of the byte). The Byte Count field specifies the 
quantity of complete bytes of data.
The status of coils 27-20 is shown as the byte value CD hex, or binary 1100 1101.
Coil 27 is the MSB of this byte, and coil 20 is the LSB. Left to right, the status of coils 27 through 
20 is ON-ON-OFF-OFF-ON-ON-OFF-ON.
By convention, bits within a byte are shown with the MSB to the left, and the LSB to the right. 
Thus the coils in the first byte are '27 through 20', from left to right, The next byte has coils '35 
through 28', left to right. As the bits are transmitted serially, they flow from LSB to MSB: 20…27, 
28...35, and so on.
In the last data byte, the status of coils 56-52 is shown as the byte value 1B hex, or binary 0001 
1011. Coil 56 is in the fourth bit position from the left, and coil 52 is the LSB of this byte. The 
status of coils 56 through 52 is ON-ON-OFF-ON-ON.
Note how the three remaining bits (toward the high order end) are zero-filled.
If the request is not applicable an exception response will be sent. 

For more information about the exception responses,  refer to Exception responses on page 124.

Header Slave 
address

Function Starting address Number of data items Error 
check

Trailer

-- 11(h) 01(h) Hi
00(h)

Low
13(h)

Hi
00(h)

Low
25(h)

-- --

Header Slave 
address

Funct. Byte 
count

Data Error 
check

Trailer

-- 11(h) 01(h) 05(h) (Coil
27-20 
CD(h)

(Coil
35-28 
6B(h)

(Coil
43-36 
B2(h)

(Coil
51-44 
0E(h)

(Coil
56-52 
1B(h)

-- --
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10.5.2  Function 02: READ INPUT STATUS

In the UFC Modbus protocol, function 1 and 2 perform the same processing and are 
interchangeable.

For more information about the exception responses,  refer to Exception responses on page 124.

10.5.3  Function 03: READ MULTIPLE HOLDING REGISTERS

Description
Function 03 reads the binary content of holding registers (4X references) in the slave.
Broadcast is not supported.
The maximum number of registers at each request is limited to 125 registers, 125 integers or 62 
long integers or 62 floats or 31 doubles.

Query
The query message specifies the starting register and the quantity of registers to be read. 
Registers are addressed starting at zero. Registers 1...16 are addressed as 0...15.

Example
Here is an axample of a request to read registers 40108...40110 from slave device 17:

Response

The register data in the response message are packed as two bytes per register, with the binary 
contents right justified within each byte. For each register the first byte contains the high order 
byte, the second byte contains the low order bits.

Header Slave 
address

Function Starting address Number of data items Error 
check

Trailer

-- 11(h) 03(h) Hi
9C(h)

Low
AB(h)

Hi
00(h)

Low
03(h)

-- --

Table 10-2: Example read holding registers

Header Slave 
addr.

Funct. Byte 
count

Data Error 
check

Trailer

-- 11(h) 03(h) 06(h) (Reg.
40108
Hi) 
02(h)

(Reg.
40108
Low)
2B(h)

(Reg.
40109
Hi)
00(h)

(Reg.
40109
Low)
00(h)

(Reg.
40110
Hi)
00(h)

(Reg.
40110
Low)
64(h)

-- --

Table 10-3: Response read holding registers
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The contents of register 40108 are shown as the two byte values of 02 2B hex (555 decimal).
The contents of register 40109 is 00 00 hex (0 decimal) and of register 40110 is 00 64 hex (100 
decimal).

If the request is not applicable, an exception response will be sent.
For more information,  refer to Exception responses on page 124.

10.5.4  Function 04: READ INPUT REGISTERS

In the UFC Modbus protocol, function 3 and 4 perform the same processing and are 
interchangeable.

10.5.5  Function 05: WRITE SINGLE COIL

Description
Function 05 forces a single coil to either ON or OFF (0x reference). 
When the address is a broadcast, all slaves will process the request.

Query
The query message specifies the coil reference to be forced. Coils are addressed starting at zero 
(coil 1 is addressed as zero).
The requested ON/OFF status is specified by a constant in the query data field. A value of FF 00 
hex requests the coil to be ON. A value of 00 00 requests it to be OFF. All other values are illegal 
and do not affect the coil and generate an exception.

Example
Here is an example of a request to force coil 173 ON in slave device 17:

Response
The normal response is an echo of the query, returned after the coils state has been forced.

If the request is not applicable an exception response will be sent.

For more information about the exception responses,  refer to Exception responses on page 124.

Header Slave 
address

Function Starting address Number of data items Error 
check

Trailer

-- 11(h) 05(h) Hi
9C(h)

Low
EC(h)

Hi
FF(h)

Low
00(h)

-- --

Header Slave 
address

Funct. Coil address Data Error 
check

Trailer

-- 11(h) 05(h) (Hi) 
00(h)

Low
AC(h)

Hi
FF(h)

Low
00(h)

-- --
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10.5.6  Function 06: WRITE SINGLE HOLDING REGISTER

Description
Function 06 presets a value into a single holding register (4x reference).
When the address is a broadcast, all slaves will process the request.

Query
The query specifies the register reference to be preset. Registers are starting at address zero. 
The requested value (preset) is specified in the data field, which is a 16-bit value.

Example
Here is an example of a request to pre-set register 40002 to 00 03 in slave 17.

Response
The response message is an echo of the query, returned after the register contents have been 
pre-set.

If the request is not applicable, an exception response will be sent.
For more information about exception responses,  refer to Exception responses on page 124.

Header Slave 
address

Function Register address Data Error 
check

Trailer

-- 11(h) 06(h) Hi
9C(h)

Low
42(h)

Hi
00(h)

Low
03(h)

-- --

Table 10-4: Example write single holding register

Header Slave 
address

Function Register address Data Error 
check

Trailer

-- 11(h) 06(h) Hi
9C(h)

Low
42(h)

Hi
00(h)

Low
03(h)

-- --

Table 10-5: Response write single holding register
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10.5.7  Function 08: DIAGNOSTICS

Description
Function 8 provides a test for checking the communication system between the master and the 
slave.

Query
The function uses a two-byte sub-function field in the query to define the test to be performed:

Only sub-function 0 is supported, which response is to loop back the query data. 
Function 8 is only supported in slave mode.

10.5.8  Function 15: WRITE MULTIPLE COILS

Description
Function 15 forces each coil (0x reference) in a sequence of coils to either ON or OFF.
When the address is a broadcast, all slaves will process the request.

Query
The query message specifies the coil reference to be forced. Coils are addressed starting at zero 
(coil 1 is addressed as 0).

Example
Here is an example of a request to force a series of coils starting at coil 20 in slave 17. The query 
data contents are two bytes CD 01 hex, the binary bits correspond to the coils in the following 
way: 

(X means don’t care and are made zero.)

The first byte transmitted (CD) addressed coils 27…20, where by the least significant bit 
addresses the lowest coil (20) in this set.
The next byte transmitted (01) addresses coils 29 and 28, with the least significant bit addressing 
the lowest coil (28) in this set. Unused bits in the last data byte should be left zero.

Request

Header Slave address Function Sub-function Data Hi+Lo Error check Trailer

-- 11(h) 08(h) 00 00(h) A1B8(h) -- --

Table 10-6: Diagnostics

Bit 1 1 0 0 1 1 0 1 0 0 0 0 0 0 0 1

Coil 27 26 25 24 23 22 21 20 X X X X X X 29 28

Header Slave 
addr.

Fct. Coil address Quantity of 
points

Byte 
counts

Force data Error 
check

Trailer

-- 11(h) 0F(h) Hi
00(h)

Low
13(h)

Hi
00(h)

Low
0A(h)

02(h) Hi
CD(h)

Low
01(h)

-- --
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Response
The normal response returns the slave address, function code, starting address, and quantity of 
coils forced.

If the request is not applicable an exception response will be sent.

For more information about exception responses,  refer to Exception responses on page 124 .

Header Slave 
address

Function Coil address Quantity of points Error 
check

Trailer

-- 11(h) 0F(h) Hi
00(h)

Low
13(h)

Hi
00(h)

Low
0A(h)

-- --
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10.5.9  Function 16: WRITE MULTIPLE HOLDING REGISTERS

Description
Function 16 pre-sets values into a sequence of holding registers (4x reference).
When the address is a broadcast, the function pre-sets the same register references in all 
attached slaves.

Query
The query message specifies the register references to be pre-set. Registers are addressed 
starting at zero (register 1 is addressed as 0).

Example
Here is an example of a request to pre-set two registers starting at 40002 to 00 0A end 01 02 hex, 
in slave device 17.

Response
The normal response returns the slave address, the function code, starting address, and 
quantity of registers pre-set:

If the request is not applicable, an exception response will be sent.

For more information about exception responses,  refer to Exception responses on page 124.

Hea-
der

Slave 
addr.

Fct. Starting 
address

Quantity Byte 
counts

Data Error 
check 

Trai-
ler

- 11(h) 10(h) Hi
9C(h)

Low
41(h)

Hi
00(h)

Low
02(h)

04(h) Hi
00(h)

Low
0A(h)

Hi
01(h)

Low
02(h)

- -

Header Slave 
address

Function Starting
address

Quantity
of points

Error 
check

Trailer

-- 11(h) 10(h) Hi
9C(h)

Low
41(h)

Hi
00(h)

Low
02(h)

-- --

Table 10-7: Response multiple holding registers
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10.5.10  Exception responses

Except for broadcast messages, a master device expects a normal response, when it sends a 
query to a slave device. One of the four possible events can occur upon the master’s query:

• If the slave device receives the query without a communication error and can handle the 
query normally, it returns a normal response.

• If the slave does not receive the query due to a communication error, no response is 
returned. The master program will eventually process a timeout condition for the query.

• If the slave receives the query, but detects a communication error (parity, CRC, LRC), no 
response is returned. The master program will eventually process a timeout condition for the 
query.

• If the slave receives the query without a communication error, but cannot handle it, the slave 
will return an exception response informing the master of the nature of the error.

The exception response message has two fields that differentiate it from a normal response, the 
Function code field and the Data field.

1. Function Code Field
In a normal response the slave echoes the function code of the original query in the function 
code field of the response. All function codes have a most significant bit of 0.
In an exception response the slave sets the most significant bit of the function code to 1.

The master recognises the exception response by means of this bit and can examine the data 
field for the exception code.

2. Data Field
In an exception response the slave returns an exception code in the data field. This defines the 
slave condition that caused the exception.

The exception response message:

Exception codes (for example)

Header Slave address Function Exception code Error check Trailer

Code Name Meaning

01 Illegal function The function code in the request 
is not an allowable action for the 
slave.

02 Illegal data address The data address received in the 
query is not an allowable address 
for the slave.
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10.6  Handling of large data types

The standard Modbus specification does not explain how data types larger than 16 bits should be 
handled. The standard Modbus functions to modify holding registers are used for handling 
larger data types.
Function 03 (read multiple holding registers), function 06 (write single holding register), and 
function 16 (write multiple holding registers) are used to read or modify these data types.
Each register area contains a datatype.

To be compatible with older systems, a parameter 8.1.1.6 COMPATIBILITY MODE controls how 
the registers are counted. 

• In the "Modicon compatible mode", each address refers to  a 16 bit register. Large data types 
will occupy multiple addresses.

• In the "not-Modicon compatible mode",  each address refers to one data item, independent of 
of its type (length). Note that function 6 in not-Modicon compatible mode will also write one 
type of the accompanying data type!

The supported data types are:

• Boolean
• Integer (16 bit)
• Long integer (32 bit)
• Long long integer (64 bit)
• Float (32 bit)
• Double (64 bit)
• ASCII 8 Characters (64 bit)
• ASCII 16 Characters (128 bit)

The register ranges for each data type:

Note that in Modicon compatible modeModicon compatible modeModicon compatible modeModicon compatible mode each data type larger than 16 bits should be addressed as 
16-bit registers. For instance the first float is located at address 7000/7001; the next float is 
located at address 7002/7003.

Function Address range Data Type Numbers of registers to request for 
each data type

Modicon
compatible

Not Modicon
compatible

1, 2, 5, 15 1000...2999 Boolean 1 1

3, 4, 6, 16 3000...3999 Integer (16 bit) 1 1

4000...4999 Long integer (32 
bit)

2 1

5000...5999 Long long integer 
(64 bit)

4 1

7000...8999 Float (32 bit) 2 1

9000...9999 Double (64 bit) 4 1

3, 16 13000...13999 ASCII (8 char.) 4 1

14000...14999 ASCII (16 char.) 8 1
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A double would be accessed by four 16-bit registers, so the first double 6000/6001/6002/6003 
and the next double 6004/6005/6006/6007.

The data in the chapter 8.4 MODBUS MAPPING ASSIGNMENTS is printed as it should be 
addressed in not-Modicon compatible modenot-Modicon compatible modenot-Modicon compatible modenot-Modicon compatible mode.

10.6.1  Floating point representation

The exponent is biased by 127.
The mantissa is 24 bits with the most significant bit 1 (not stored), 23 bit stored.

10.6.2  Double representation

The exponent is biased by 127.
The mantissa is 53 bits with the most significant bit 1 (not stored), 52 bit stored.

Double precision bits

Double precision bits 2

Sign + (Biased) 
Exponent

Exponent + Mantissa 3 
(high)

Mantissa 2 Mantissa 1 (low)

SEEE EEEE E MMM MMMM MMMM MMMM MMMM MMMM

Sign + 
(Biased) 
Exponent

Exponent + 
Mantissa

Mantissa 6 Mantissa 5

SEEE EEEE EEEE MMMM MMMM 
MMMM

MMMM 
MMMM

Mantissa 4 Mantissa 3 Mantissa 2 Mantissa 1

MMMM 
MMMM

MMMM 
MMMM

MMMM 
MMMM

MMMM 
MMMM
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10.7  Transmit sequence of data types

Integers
Integers are transmitted and stored with the most significant part first.
Example:Example:Example:Example:
Integer value 1790 decimal (6FE hexadecimal) is transmitted as:

Long integers
Long integers can be transmitted in two possible ways.
Example:Example:Example:Example:
Long integer value 305419896 (12345678 hexadecimal).
 The transmit order in both modes:

Example long integers

Long long integers
Long long integers can be transmitted in two ways.
Example:Example:Example:Example:
Long integer value 305419896 (12345678 hexadecimal).
The transmit order in both modes:

Example long long integer

Floats
Floats can be transmitted in two ways.
Example:Example:Example:Example:
The float number 4.125977 will give the IEEE representation.

First transmitted byte in data 
field

Second transmitted byte in data 
field

06 FE

Table 10-8: Example integer (16 bit)

Normal 
mode

(1)
12h

(2)
34h

(3)
56h

(4)
78h

Reversed 
mode

(3)
56h

(4)
78h

(1)
12h

(2)
34h

Normal 
mode

(1)
12h

(2)
34h

(3)
56h

(4)
78h

(5)
0h

(6)
0h

(7)
0h

(8)
0h

Reversed 
mode

(3)
56h

(4)
78h

(1)
12h

(2)
34h

(7)
0h

(8)
0h

(5)
0h

(6)
0h
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Example IEEE

A biased exponent of 129 (81 hexadecimal) is exponent 2.
A positive sign
Mantissa = 4 + 1/8 + 1/1024. Note that the first bit is not stored! 

 The transmit order in both modes:

Doubles
Doubles can be transmitted in two ways.
Example:Example:Example:Example:
The double number 4.125000001862645 will give the IEEE representation:

double number example

A biased exponent of 1025 (401 hexadecimal) is exp. 2
A positive sign
Mantissa = 4 + 1/8 + 1/536870912. Note that the first bit is not stored!
The transmit order in both modes:

Doubles transmit order

Sign Exponent Mantissa

0 1000 0001 (1) 000 0100 0000 
1000 0000 0000

IEEE 754 (1)
40h

(2)
84h

(3)
08h

(4)
00h

Normal 
mode

(1)
40h

(2)
84h

(3)
08h

(4)
00h

Reversed 
mode

(3)
08h

(4)
00h

(1)
40h

(2)
84h

Sign Exponent Mantissa

0 100 0000 0001 (1)0000 1000 0000 0000 0000 0000 
0000 0010 0000 0000 0000 0000 
0000

IEEE 754 (1)
40h

(2)
10h

(3)
80h

(4)
00h

(5)
00h

(6)
20h

(7)
00h

(8)
00h

Normal 
mode

(1)
40h

(2)
10h

(3)
80h

(4)
00h

(5)
00h

(6)
20h

(7)
00h

(8)
00h

Reversed 
mode

(3)
80h

(4)
00h

(1)
40h

(2)
10h

(7)
00h

(8)
00h

(5)
00h

(6)
20h
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String 8String 8String 8String 8 will be transmitted as follows:
Example:Example:Example:Example:
Text “Best UFM” (426573742055464D Hexadecimal) 
The transmit order:

String 16String 16String 16String 16 will be transmitted as follows:
Example:Example:Example:Example:
Text “KROHNEAltosonic5” (4B524F484E45416C746F736F6E696335 Hexadecimal) 
The transmit order:

10.8  Maximum requested points

The maximum points in a single request depend on the type of data.

How to set up a redundant system:How to set up a redundant system:How to set up a redundant system:How to set up a redundant system:
If one or more UFC systems are used with one host system, the host system must support 
Modbus master mode. The UFC will then operate in Modbus slave mode.

Normal 
mode

(1)
42h

(2)
65h

(3)
73h

(4)
74h

(5)
20h

(6)
55h

(7)
46h

(8)
4Dh

Nor
mal 
mo
de

(1)
4Bh

(2)
52h

(3)
4Fh

(4)
48h

(5)
4Eh

(6)
45h

(7)
41h

(8)
6Ch

(9)
74h

(10)
6Fh

(11)
73h

(12)
6Fh

(13)
6Eh

(14)
69h

(15)
63h

(16)
35h

Data type Modicon compatible mode
(count on 16 bit registers)

Not Modicon compatible mode
(count on type)

Boolean 2000 2000

Integer 125 125

Long integer 124 62

Float 124 62

Double 124 31

ASCII 124 62 (8 characters) / 31 (16 
characters)
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10.9  Set-up of the UFC modbus driver

10.9.1  Driver settings

The driver can be configured as follows:

• Modbus address (1...247)
• Modbus mode ASCII-mode and RTU mode
• Compatibility mode (modicon compatible or not)
• Byte order per variable type
• Baudrate
• Databits
• Stopbits
• Parity Even/Odd/No/mark or space
• Stop bits 1 or 2
• Timeouts
• Wired connection, 2wires or 3/4 Half and full duplex
• ASCII start code quantity of end chars, end code

10.9.2  Hardware set-up

To set-up the Modbus communication, first the hardware must be set-up.
The UFC is equipped with a RS485/RS422 Communication Card which provide 4 serial 
communication channels These channels are free for communication with host systems.

10.9.3  Software set-up

Now set-up the software, all the settings for the Modbus driver is done via the Configuration and 
monitoring tool. For more detailed information,  refer to MCD tool on page 57.

First set the parameters for the communication line:

• 8.1.1.4: Set Modbus address for the first channel
• 8.1.1.5: Set to ASCII or RTU
• 8.1.1.6: Set to active or not, depending on your application compatibility with Modicon
• 8.1.1.8: Set the Baudrate
• 8.1.1.9: Set to 8 data bits
• 8.1.1.10: Set to 1 or 2 stop bits
• 8.1.1.11: Set parity to None, Even or Odd
• 8.1.1.20: for RS485RS485RS485RS485, set to 2 wires; for RS422RS422RS422RS422, set to 3/4 wires

The UFC-5 is not available as Master.
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10.9.4  Possible problems

Specific RS485 checks:Specific RS485 checks:Specific RS485 checks:Specific RS485 checks:

• Are the jumpers installed to terminate the loop? (only if UFC-V is at the end of the line)
• Is the polarity correct? Are the lines swapped?

Other checks:

• Are the baudrate,number of stop bits and the parity set-up correctly?
• Are both systems in the same mode (ASCII / RTU)?
• Is the Modbus address Slave ID correct?
• RTU requires precise timing specifications, some of the RS485 -> RS232/422 converters 

perform data buffering that can give problems. Try ASCII mode if this happens.
• The Slave device will not give any response when it is addressed with a broadcast (SlaveID=0).
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10.10  Modbus register mapping

Registers are mapped to specific address ranges according to both data and register type:

10.10.1  Input Registers (read-only): Boolean; basic address 1000

Data type Register type Read
command(s)

Write
command(s)

Address range

Integer
(16 bit)

Input register 4 n.a. 3000..3499

Holding register 3 6, 16 3500..3999

Long integer
(32 bit)

Input register 4 n.a. 5000..5499

Holding register 3 6, 16 5500..5999

Double
(64 bit)

Input register 4 n.a. 6000..6499

Holding register 3 6, 16 6500..6999

Float
(32 bit)

Input register 4 n.a. 7000..7499

Holding register 3 6, 16 7500..7999

Long long
(64 bit)

Input register 4 n.a. 8000..8499

Holding register 3 6, 16 8500..8999

INFORMATION!
The relative addresses listed in the tables below are addresses relative to the starting address of 
the designated register group.

Start
address

Short description Internal register name

1 Test register t.b.d.

2 A: System set-up Alarm Reynolds Parameter Array 
(fail) 

A Setup Reynolds

3 A: System set-up Alarm Viscosity Parameter Array 
(fail) 

A Setup Viscosity

4 A: Down All Paths, no custody transfer standard 
(FAILED) 

A Fail All Paths

5 A: Down Paths, Custody Transfer unreliable 
(FAILED) 

A Fail Paths result unreliable

6 A: Low Reliability, Custody Transfer unreliable 
(FAILED) 

A Low Acceptance

7 A: Out of range FLOW A Out of Range Flow

8 A: Out of range REYNOLDS A Out of Range Reynolds

9 A: Out of range PATH SUBSTITUTION A Out of Range PathSubst

10 A: Out of range new Path substution profile A Out of Range New PathSubst

11 A: Time calculation error A Time calculation Error

12 A: Fail on a used input (T,P etc) A Fail on used Input

13 A: Out of range Gain average Gain average high

14 A: Out of range SNR A SNR average low

15...16 Reserved

17 A: Out of range: Temperature Body A Temperature Body OOR

18 A: Override value used: Temperature Body A Temperature Body OVR 
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19 A: Out of range: Temperature Line (if used 
internally)

A Temperature Line OOR 

20 A: Override value used: Temperature Line (if used 
internally)

A Temperature Line OVR 

21 A: Out of range: Temperature Sampler ( if used 
internally) 

A Temperature Sampler OOR 

22 A: Override value used: Temperature Sampler (if 
used internally) 

A Temperature Sampler OVR 

23 A: Out of range: Pressure Line (if used internally) A Pressure Line OOR 

24 A: Override value used: Pressure Line (if used 
internally) 

A Pressure Line OVR 

25 A: Out of range: kinematic viscosity liquid/used (if 
used internally) 

A Visco Kinematic OOR 

26 A: Override value used: kinematic Viscosity (if used 
internally) 

A Visco Kinematic OVR 

27 A: Out of range: Dynamic viscosity (if used 
internally) 

A Visco Dynamic OOR 

28 A: Override value used: Dynamic Viscosity (if used 
internally)

A Visco Dynamic OVR 

29 A: Out of range: Density (if used internally) A Density OOR 

30 A: Override value used: Density (if used internally) A Density OVR 

31...40 Reserved

41 W: Down Paths, but Custody Transfer reliable W Fail Paths but result Reliable

42 W: Fail Path Full Pipe detection W Fail Path Fullpipe Detection

43 W: Low Acceptance W Low Acceptance

44 W: Incoherence Fwd and Rev Velociy paths W Incoherence Fwd and Rev Velocity

45 W: Instability flow W Instability Flow

46 W: Instability SoS W Instability SoS

47 W: Flow instability results in Reynolds Correction 
on Hold

W Instability Reynolds Correction Hold

48 W: Profile quality Swirl W Profile quality Swirl

49 W: Profile quality Assymetry W Profile quality Assymetry 

50 W: Overrun System W Overrun System

51 W: Gain average high W Gain average high

52 W: SNR average low W SNR average low

53...64 Reserved

65 S: Flow direction S Flow_Direction

66 S: measured Flow is below Low flow cut-off value S LowFLowCutOff

67 S: Reset totals S Reset_Totals

68 S: Reset Alarms S Reset_Alarms

69 S: Reset Procestime S Reset_ProcesTime

70 S: Reset Path Substitution S Reset_Path Substitution

71 S: Initialisation after configuration setup change S Initialisation

72 S: FWD Resetable Totalisers Rollover to zero S FWD Resetable Totals Roll Zero

73 S: REV Resetable Totalisers Rollover to zero S REV Resetable Totals Roll Zero

74 S: FWD Non Resetable Totalisers Rollover to zero S FWD NonReset Totals Roll Zero

Start
address

Short description Internal register name
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75 S: REV Non Resetable Totalisers Rollover to zero S REV NonReset Totals Roll Zero

76...90 Reserved

91 S: Out of range: Temperature Body (if also exported 
input) 

S Temperature Body OOR

92 S: Override value used: Temperature Body (if also 
exported input)

S Temperature Body OVR

93 S: Out of range: Temperature Line (if exported 
input)

S Temperature Line OOR

94 S: Override value used: Temperature Line (if 
exported input) 

S Temperature Line OVR

95 S: Out of range: Temperature Sampler (if exported 
input) 

S Temperature Sampler OOR

96 S: Override value used: Temperature Sampler (if 
exported input) 

S Temperature Sampler OVR

97 S: Out of range: Pressure Line (if exported input) S Pressure Line OOR

98 S: Override value used: Pressure Line (if exported 
input) 

S Pressure Line OVR

99 S: Out of range: kinematic viscosity liquid/used (if 
exported input)

S Visco Kinematic OOR

100 S: Override value used: kinematic Viscosity (if 
exported input) 

S Visco Kinematic OVR

101 S: Out of range: Dynamic viscosity (if exported 
input) 

S Visco Dynamic OOR

102 S: Override value used: Dynamic Viscosity (if 
exported input) 

S Visco Dynamic OVR

103 S: Out of range: Density (if exported input) S Density OOR

104 S: Override value used: Density (if exported input) S Density OVR

105 S: Out of range: Spare1 (only exported input) S Spare1 OOR

106 S: Override value used: Spare1 (only exported 
input)

S Spare1 OVR

107 S: Out of range: Spare2 (only exported input) S Spare2 OOR

108 S: Override value used: Spare2 (only exported 
input)

S Spare2 OVR

109 S: Out of range: Spare3 (only exported input) S Spare3 OOR

110 S: Override value used: Spare3 (only exported 
input)

S Spare3 OVR

111 S: Out of range: Spare4 (only exported input) S Spare4 OOR

112 S: Override value used: Spare4 (only exported 
input)

S Spare4 OVR

113 S: Out of range: Spare5 (only exported input) S Spare5 OOR

114 S: Override value used: Spare5 (only exported 
input)

S Spare5 OVR

115...130 Reserved

131...138 S: Path Unreliable 1-8 Status Paths (array) 0…7

139...146 S: Path Down 1-8 Status Paths (array) 0…7

147...154 S: Path Down: Deviation SoS too large 1-8 Status Paths (array) 0…7

155...162 S: Path Down: Signal lost 1-8 Status Paths (array) 0…7

163...170 S: Path Gain Warning 1-8 Status Paths (array) 0…7

Start
address

Short description Internal register name
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10.10.2  Input Registers (read-only): Integer (16-bit); basic address 3000

171...178 S: Path Gain Alarm 1-8 Status Paths (array) 0…7

179...186 S: Path SNR Warning 1-8 Status Paths (array) 0…7

187...194 S: Path SNR Alarm 1-8 Status Paths (array) 0…7

Start
address

Short description Default Unit Internal Register Name

1 Test register TestRegister uint16

2 Flow [m3/h] Flow

3 Velocity [m/s] Velocity

4 SoS average [m/s] SoS average

5 Gain average [dB] Gain average

6 SN ratio average [dB] SNratio average

7 Reynolds indication by profile [ ] Reynolds By Profile

8 Reynolds indication by optional 
viscosity input

[ ] Reynolds By ViscoInput

9 Kin. Viscosity indication by profile [cSt] ViscoKin By Profile

10 Kin Viscosity indication by 
optional viscosity input

[cSt] ViscoKin By ViscoInput

11 Profile diagnostics Swirl % [%] Profile Swirl

12 Profile diagnostics Asymmetry % [%] Profile Assymetry

13 Profile N (CT) paths failing [ ] Profile Valid PathsFailed

14 Overall weighted reliability [%] Acceptance Flow 

15 Sos band Max [m/s] SoS band Max

16 Sos band Min [m/s] SoS band Min

17 Gain band Max [dB] Gain band Max

18 Gain band Min [dB] Gain band Min

19 SN ratio band Max [dB] SNratio band Max

20 SN ratio band Min [dB] SNratio band Min

21 Correction factor KbT Thermal 
Body expansion

[ ] Correction Kbt

22 Correction factor Kbp Pressure 
Body expansion

[ ] Correction Kbp

23 Correction factor Kr, Reynolds [ ] Correction Kr

24 INPUT: Temperature Body [oC] Temperature Body

25 INPUT: Temperature Line [oC] Temperature Line

26 INPUT: Temperature Sampler [oC] Temperature Sampler

27 INPUT: Pressure Line [barG] Pressure Line

28 INPUT: Viscosity Kinematic [cSt] ViscosityKin

29 INPUT: Viscosity Dynamic [cP] ViscosityDyn

30 INPUT: Density kg/m3 Density

Start
address

Short description Internal register name
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31 INPUT: Spare1 Input (export 
input only)

[ ] Spare1

32 INPUT: Spare2 Input (export 
input only)

[ ] Spare2

33 INPUT: Spare3 Input (export 
input only)

[ ] Spare3

34 INPUT: Spare4 Input (export 
input only)

[ ] Spare4

35 INPUT: Spare5 Input (export 
input only)

[ ] Spare5

36 Number of Actual CT alarms [ ] N Actual Alarms

37 Number of Actual CT Warnings [ ] N Actual Warnings

38...45 RESERVED

46...53 Path 1-8, velocity [m/s] Path Velocity

54...61 Path 1-8, SoS [m/s] Path SoS

62...69 Path 1-8, Gain [dB] Path Gain

70...77 Path 1-8, SNR [dB] Path SNRatio

78...85 Path 1-8, Acceptance [%] Path Acceptance

86...110 RESERVED

111 Statistics: Flow average [m3/h] AV Flow

112 Statistics: Flow running average [m3/h] AV Tau Flow

113 Statistics: Flow standard 
deviation 

[%] SD Flow

114 Statistics: Flow running standard 
deviation 

[%] SD Tau Flow

115 Statistics: SoS average [m/s] AV SoS

116 Statistics: SoS standard deviation [%] SD SoS

117...124 Statistics: Path 1-8, velocity 
average

[m/s] PATH AV Velocity

125...132 Statistics: Path 1-8, velocity 
standard deviation

[%] PATH SD Velocity

133...140 Statistics: Path 1-8, SoS average [m/s] PATH AV SoS

141...148 Statistics: Path 1-8, SoS standard 
deviation

[%] PATH SD SoS

149...156 Statistics: Path 1-8, Gain average [dB] PATH AV Gain

157...164 Statistics: Path 1-8, Gain 
standard deviation

[%] PATH SD Gain

165...172 Statistics: Path 1-8, SNR average [dB] PATH AV SNratio

173...180 Statistics: Path 1-8, SNR 
standard deviation

[%] PATH SD SNratio

181...188 Statistics: Path 1-8, Acceptance 
average

[%] PATH AV Acceptance

189...196 Statistics: Path 1-8, Acceptance 
standard deviation

[%] PATH SD Acceptance

Start
address

Short description Default Unit Internal Register Name
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10.10.3  Holding Registers (read/write): Integer (16-bit); basic address 3500

10.10.4  Input Registers (read-only): Long integer (32-bit); basic address 4000

INFORMATION!
Register reserved for testing communications and protocol handling with this type of register, 
without affecting the operation of the flowmeter.

Start
address

Short description Internal Register Name

1 Test register TestRegister uint16

2 Reset resetable 
Totalisers+alarms/warnings/status/procestime

Reset Totalisers

3 Reset alarms/warnings/status Reset Alarms and Status

4...10 Reserved

11 OVERRIDE Mode Temperature Body Override Mode TempBody

12 OVERRIDE Mode Temperature Line Override Mode TempLine

13 OVERRIDE Mode Temperature Sampler Override Mode TempSamp

14 OVERRIDE Mode Pressure Line Override Mode Presline

15 OVERRIDE Mode Viscosity Kinematic Override Mode ViscoKin

16 OVERRIDE Mode Viscosity Dynamic Override Mode ViscoDyn

17 OVERRIDE Mode Density Override Mode Density

18 OVERRIDE Mode Spare1 Override Mode Spare1

19 OVERRIDE Mode Spare2 Override Mode Spare2

20 OVERRIDE Mode Spare3 Override Mode Spare3

21 OVERRIDE Mode Spare4 Override Mode Spare4

22 OVERRIDE Mode Spare5 Override Mode Spare5

INFORMATION!
Register reserved for testing communications and protocol handling with this type of register, 
without affecting the operation of the flowmeter.

Start
address

Short description Default unit Internal Register Name

1 Test register - TestRegister uint32

2 Reserved

3 Reserved

4 Reserved

5...10 Reserved

11 Resetable Totaliser RELIAB 
Gross Forward

[m3] Total Reset FWD Reliab

12 Resetable Totaliser RELIAB 
Gross Reverse

[m3] Total Reset REV Reliab

13 Resetable Totaliser FAIL Gross 
Forward

[m3] Total Reset FWD Fail

14 Resetable Totaliser FAIL Gross 
Reverse

[m3] Total Reset REV Fail
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15 Resetable Totaliser SUM Gross 
Forward

[m3] Total Reset FWD Sum

16 Resetable Totaliser SUM Gross 
Reverse

[m3] Total Reset REV Sum

17 NON-Resetable Totaliser RELIAB 
Gross Forward

[m3] Total NonReset FWD Reliab 

18 NON-Resetable Totaliser RELIAB 
Gross Reverse

[m3] Total NonReset REV Reliab 

19 NON-Resetable Totaliser FAIL 
Gross Forward

[m3] Total NonReset FWD Fail 

20 NON-Resetable Totaliser FAIL 
Gross Reverse

[m3] Total NonReset REV Fail

21 NON-Resetable Totaliser SUM 
Gross Forward

[m3] Total NonReset FWD Sum 

22 NON-Resetable Totaliser SUM 
Gross Reverse

[m3] Total NonReset REV Sum 

23...50 Reserved

51 A: System set-up Alarm Reynolds 
Parameter Array (fail) 

[alarm] Alarms Pipe

51 A: System set-up Alarm Viscosity 
Parameter Array (fail) 

[alarm] Alarms Pipe

51 A: Down All Paths, no custody 
transfer standard (FAILED) 

[alarm] Alarms Pipe

51 A: Down Paths, Custody Transfer 
unreliable (FAILED) 

[alarm] Alarms Pipe

51 A: Low Reliability, Custody 
Transfer unreliable (FAILED) 

[alarm] Alarms Pipe

51 A: Out of range FLOW [alarm] Alarms Pipe

51 A: Out of range REYNOLDS [alarm] Alarms Pipe

51 A: Out of range PATH 
SUBSTITUTION 

[alarm] Alarms Pipe

51 A: Out of range new Path 
substution profile 

[alarm] Alarms Pipe

51 A: Time calculation error [alarm] Alarms Pipe

51 A: Fail on a used input (T,P etc) [alarm] Alarms Pipe

51 A: Out of range Gain average [alarm] Alarms Pipe

51 A: Out of range SNR average [alarm] Alarms Pipe

52 A: Out of range: Temperature 
Body

[alarm] Alarms Inputs

52 A: Override value used: 
Temperature Body

[alarm] Alarms Inputs

52 A: Out of range: Temperature 
Line (if used internally) 

[alarm] Alarms Inputs

52 A: Override value used: 
Temperature Line (if used 
internally) 

[alarm] Alarms Inputs

52 A: Out of range: Temperature 
Sampler (if used internally)

[alarm] Alarms Inputs

52 A: Override value used: 
Temperature Sampler (if used 
internally) 

[alarm] Alarms Inputs

Start
address

Short description Default unit Internal Register Name
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52 A: Out of range: Pressure Line (if 
used internally)

[alarm] Alarms Inputs

52 A: Override value used: Pressure 
Line (if used internally)

[alarm] Alarms Inputs

52 A: Out of range: kinematic 
viscosity liquid/used (if used 
internally)

[alarm] Alarms Inputs

52 A: Override value used: kinematic 
Viscosity (if used internally) 

[alarm] Alarms Inputs

52 A: Out of range: Dynamic 
viscosity (if used internally) 

[alarm] Alarms Inputs

52 A: Override value used: Dynamic 
Viscosity (if used internally) 

[alarm] Alarms Inputs

52 A: Out of range: Density (if used 
internally) 

[alarm] Alarms Inputs

52 A: Override value used: Density (if 
used internally)

[alarm] Alarms Inputs

53 W: Down Paths, but Custody 
Transfer reliable

[warning] Warnings Pipe

53 W: Fail Path Full Pipe detection [warning] Warnings Pipe

53 W: Low Acceptance [warning] Warnings Pipe

53 W: Incoherence Fwd and Rev 
Velociy paths

[warning] Warnings Pipe

53 W: Instability flow [warning] Warnings Pipe

53 W: Instability SoS [warning] Warnings Pipe

53 W: Flow instability results in 
Reynolds Correction on Hold

[warning] Warnings Pipe

53 W: Profile quality Swirl [warning] Warnings Pipe

53 W: Profile quality Assymetry [warning] Warnings Pipe

53 W: Overrun System [warning] Warnings Pipe

53 W: Out of range Gain average [warning] Warnings Pipe

53 W: Out of range SNR average [warning] Warnings Pipe

54 S: Flow direction [status] Status Pipe

54 S: measured Flow is below Low 
flow cut-off value

[status] Status Pipe

54 S: Reset totals [status] Status Pipe

54 S: Reset Alarms [status] Status Pipe

54 S: Reset Procestime [status] Status Pipe

54 S: Reset Path Substitution [status] Status Pipe

54 S: Initialisation after 
configuration setup change

[status] Status Pipe

54 S: FWD Resetable Totalisers 
Rollover to zero

[status] Status Pipe

54 S: REV Resetable Totalisers 
Rollover to zero

[status] Status Pipe

54 S: FWD Non Resetable Totalisers 
Rollover to zero

[status] Status Pipe

54 S: REV Non Resetable Totalisers 
Rollover to zero

[status] Status Pipe

Start
address

Short description Default unit Internal Register Name
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55 S: Out of range: Temperature 
Body (if also exported input)

[status] Status Inputs Exp

55 S: Override value used: 
Temperature Body (if also 
exported input)

[status] Status Inputs Exp

55 S: Out of range: Temperature 
Line (if exported input)

[status] Status Inputs Exp

55 S: Override value used: 
Temperature Line (if exported 
input)

[status] Status Inputs Exp

55 S: Out of range: Temperature 
Sampler (if exported input)

[status] Status Inputs Exp

55 S: Override value used: 
Temperature Sampler (if 
exported input)

[status] Status Inputs Exp

55 S: Out of range: Pressure Line (if 
exported input)

[status] Status Inputs Exp

55 S: Override value used: Pressure 
Line (if exported input)

[status] Status Inputs Exp

55 S: Out of range: kinematic 
viscosity liquid/used (if exported 
input)

[status] Status Inputs Exp

55 S: Override value used: kinematic 
Viscosity (if exported input)

[status] Status Inputs Exp

55 S: Out of range: Dynamic 
viscosity (if exported input)

[status] Status Inputs Exp

55 S: Override value used: Dynamic 
Viscosity(if exported input)

[status] Status Inputs Exp

55 S: Out of range: Density (if 
exported input)

[status] Status Inputs Exp

55 S: Override value used: Density (if 
exported input)

[status] Status Inputs Exp

55 S: Out of range: Spare1 (only 
exported input)

[status] Status Inputs Exp

55 S: Override value used: Spare1 
(only exported input)

[status] Status Inputs Exp

55 S: Out of range: Spare2 (only 
exported input)

[status] Status Inputs Exp

55 S: Override value used: Spare2 ( 
only exported input)

[status] Status Inputs Exp

55 S: Out of range: Spare3 (only 
exported input)

[status] Status Inputs Exp

55 S: Override value used: Spare3 
(only exported input)

[status] Status Inputs Exp

55 S: Out of range: Spare4 (only 
exported input)

[status] Status Inputs Exp

55 S: Override value used: Spare4 
(only exported input) 

[status] Status Inputs Exp

55 S: Out of range: Spare5 (only 
exported input) 

[status] Status Inputs Exp

55 S: Override value used: Spare5 
(only exported input)

[status] Status Inputs Exp

56 S: Path LowAcceptance 1 [status] Status Paths (array) 0…7

Start
address

Short description Default unit Internal Register Name
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56 S: Path LowAcceptance 2 [status] Status Paths (array) 0…7

56 S: Path LowAcceptance 3 [status] Status Paths (array) 0…7

56 S: Path LowAcceptance 4 [status] Status Paths (array) 0…7

56 S: Path LowAcceptance 5 [status] Status Paths (array) 0…7

56 S: Path LowAcceptance 6 [status] Status Paths (array) 0…7

56 S: Path LowAcceptance 7 [status] Status Paths (array) 0…7

56 S: Path LowAcceptance 8 [status] Status Paths (array) 0…7

57 S: Path Down 1 [status] Status Paths (array) 0…7

57 S: Path Down 2 [status] Status Paths (array) 0…7

57 S: Path Down 3 [status] Status Paths (array) 0…7

57 S: Path Down 4 [status] Status Paths (array) 0…7

57 S: Path Down 5 [status] Status Paths (array) 0…7

57 S: Path Down 6 [status] Status Paths (array) 0…7

57 S: Path Down 7 [status] Status Paths (array) 0…7

57 S: Path Down 8 [status] Status Paths (array) 0…7

58 S: Path SoS deviation to large 1 [status] Status Paths (array) 0…7

58 S: Path SoS deviation to large 2 [status] Status Paths (array) 0…7

58 S: Path SoS deviation to large 3 [status] Status Paths (array) 0…7

58 S: Path SoS deviation to large 4 [status] Status Paths (array) 0…7

58 S: Path SoS deviation to large 5 [status] Status Paths (array) 0…7

58 S: Path SoS deviation to large 6 [status] Status Paths (array) 0…7

58 S: Path SoS deviation to large 7 [status] Status Paths (array) 0…7

58 S: Path SoS deviation to large 8 [status] Status Paths (array) 0…7

59 S: Path Signal Lost 1 [status] Status Paths (array) 0…7

59 S: Path Signal Lost 2 [status] Status Paths (array) 0…7

59 S: Path Signal Lost 3 [status] Status Paths (array) 0…7

59 S: Path Signal Lost 4 [status] Status Paths (array) 0…7

59 S: Path Signal Lost 5 [status] Status Paths (array) 0…7

59 S: Path Signal Lost 6 [status] Status Paths (array) 0…7

59 S: Path Signal Lost 7 [status] Status Paths (array) 0…7

59 S: Path Signal Lost 8 [status] Status Paths (array) 0…7

60 S: Path Gain Warning 1 [status] Status Paths (array) 0…7

60 S: Path Gain Warning 2 [status] Status Paths (array) 0…7

60 S: Path Gain Warning 3 [status] Status Paths (array) 0…7

60 S: Path Gain Warning 4 [status] Status Paths (array) 0…7

60 S: Path Gain Warning 5 [status] Status Paths (array) 0…7

60 S: Path Gain Warning 6 [status] Status Paths (array) 0…7

60 S: Path Gain Warning 7 [status] Status Paths (array) 0…7

60 S: Path Gain Warning 8 [status] Status Paths (array) 0…7

61 S: Path Gain Alarm 1 [status] Status Paths (array) 0…7

61 S: Path Gain Alarm 2 [status] Status Paths (array) 0…7

61 S: Path Gain Alarm 3 [status] Status Paths (array) 0…7

Start
address

Short description Default unit Internal Register Name
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10.10.5  Input Registers (read-only): Double (64-bit floating point), basic address 5000

61 S: Path Gain Alarm 4 [status] Status Paths (array) 0…7

61 S: Path Gain Alarm 5 [status] Status Paths (array) 0…7

61 S: Path Gain Alarm 6 [status] Status Paths (array) 0…7

61 S: Path Gain Alarm 7 [status] Status Paths (array) 0…7

61 S: Path Gain Alarm 8 [status] Status Paths (array) 0…7

62 S: Path SNR Warning 1 [status] Status Paths (array) 0…7

62 S: Path SNR Warning 2 [status] Status Paths (array) 0…7

62 S: Path SNR Warning 3 [status] Status Paths (array) 0…7

62 S: Path SNR Warning 4 [status] Status Paths (array) 0…7

62 S: Path SNR Warning 5 [status] Status Paths (array) 0…7

62 S: Path SNR Warning 6 [status] Status Paths (array) 0…7

62 S: Path SNR Warning 7 [status] Status Paths (array) 0…7

62 S: Path SNR Warning 8 [status] Status Paths (array) 0…7

63 S: Path SNR Alarm 1 [status] Status Paths (array) 0…7

63 S: Path SNR Alarm 2 [status] Status Paths (array) 0…7

63 S: Path SNR Alarm 3 [status] Status Paths (array) 0…7

63 S: Path SNR Alarm 4 [status] Status Paths (array) 0…7

63 S: Path SNR Alarm 5 [status] Status Paths (array) 0…7

63 S: Path SNR Alarm 6 [status] Status Paths (array) 0…7

63 S: Path SNR Alarm 7 [status] Status Paths (array) 0…7

63 S: Path SNR Alarm 8 [status] Status Paths (array) 0…7

INFORMATION!
Register reserved for testing communications and protocol handling with this type of register, 
without affecting the operation of the flowmeter.

Start address 
NotModiconComp

Short description Default unit Internal Register Name

1 Test register - t.b.d.

2 Reserved

3 Reserved

4 Reserved

5...10 Reserved

11 Resetable Totaliser RELIAB 
Gross Forward

[ml]=[1E-6m3] Total Reset FWD Reliab

12 Resetable Totaliser RELIAB 
Gross Reverse

[ml]=[1E-6m3] Total Reset REV Reliab

13 Resetable Totaliser FAIL Gross 
Forward

[ml]=[1E-6m3] Total Reset FWD Fail

14 Resetable Totaliser FAIL Gross 
Reverse

[ml]=[1E-6m3] Total Reset REV Fail

15 Resetable Totaliser SUM Gross 
Forward

[ml]=[1E-6m3] Total Reset FWD Sum

Start
address

Short description Default unit Internal Register Name



 MODBUS PROTOCOL DESCRIPTION AND SET-UP 10

143

ALTOSONIC 5

www.krohne.com01/2016 - 4004360702 - MA ALTOSONIC 5 en R02

10.10.6  Input Registers (read-only): Float (32-bit floating-point); basic address 7000

16 Resetable Totaliser SUM Gross 
Reverse

[ml]=[1E-6m3] Total Reset REV Sum

17 NON-Resetable Totaliser 
RELIAB Gross Forward

[ml]=[1E-6m3] Total NonReset FWD Reliab

18 NON-Resetable Totaliser 
RELIAB Gross Reverse

[ml]=[1E-6m3] Total NonReset REV Reliab

19 NON-Resetable Totaliser FAIL 
Gross Forward

[ml]=[1E-6m3] Total NonReset FWD Fail

20 NON-Resetable Totaliser FAIL 
Gross Reverse

[ml]=[1E-6m3] Total NonReset REV Fail

21 NON-Resetable Totaliser SUM 
Gross Forward

[ml]=[1E-6m3] Total NonReset FWD Sum

22 NON-Resetable Totaliser SUM 
Gross Reverse

[ml]=[1E-6m3] Total NonReset REV Sum

INFORMATION!
Register reserved for testing communications and protocol handling with this type of register, 
without affecting the operation of the flowmeter.

Start address
NotModiconComp

Short description Default unit Internal Register Name

1 Test register - TestRegister float32

2 Flow [m3/h] Flow

3 Velocity [m/s] Velocity

4 SoS average [m/s] SoS average

5 Gain average [dB] Gain average

6 SN ratio average [dB] SNratio average

7 Reynolds indication by profile [ ] Reynolds By Profile

8 Reynolds indication by optional 
viscosity input

[ ] Reynolds By ViscoInput

9 Kin. viscosity indication by 
profile

[cSt] ViscoKin By Profile

10 Kin. viscosity indication by 
optional viscosity input

[cSt] ViscoKin By ViscoInput

11 Profile diagnostics swirl % [%] Profile Swirl

12 Profile diagnostics 
assymmetry % 

[%] Profile Assymetry

13 Profile N (CT) paths failing [ ] Profile Failed PathsWeighed

14 Overall weighted Acceptance [%] Acceptance Flow

15 SoS band Max [m/s] SoS band Max

16 SoS band Min [m/s] SoS band Min

17 Gain band Max [dB] Gain band Max

18 Gain band Min [dB] Gain band Min

19 SNratio band Max [dB] SNratio band Max

20 SNratio band Min [dB] SNratio band Min

Start address 
NotModiconComp

Short description Default unit Internal Register Name
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21 Correction factor KbT Thermal 
Body expansion

[ ] Correction Kbt

22 Correction factor Kbp 
Pressure Body Expansion

[ ] Correction Kbp

23 Correction factor Kr, Reynolds [ ] Correction Kr

24 INPUT: Temperature Body [oC] Temperature Body

25 INPUT: Temperature Line Temperature Line 

26 INPUT: Temperature Sampler Temperature Sampler

27 INPUT: Pressure Line [barG] Pressure Line

28 INPUT: Viscosity Kinematic [cSt] ViscosityKin

29 INPUT: Viscosity Dynamic [cSt] ViscosityDyn

30 INPUT: Density [kg/m3] Density

31 INPUT: Spare1 Input (export 
input only)

[ ] Spare1

32 INPUT: Spare2 Input (export 
input only)

[ ] Spare2

33 INPUT: Spare3 Input (export 
input only)

[ ] Spare3

34 INPUT: Spare4 Input (export 
input only)

[ ] Spare4

35 INPUT: Spare5 Input (export 
input only)

[ ] Spare5

36 Number of Actual CT alarms [ ] N Actual Alarms

37 Number of Actual CT Warnings [ ] N Actual Warnings

38...45 RESERVED

46...53 Path 1-8, velocity [m/s] Path Velocity

54...61 Path 1-8, SoS [m/s] Path SoS

62...69 Path 1-8, Gain [dB] Path Gain

70...77 Path 1-8,SNR [dB] Path SNratio

78...85 Path 1-8, Acceptance [%] Path Acceptance

86...110 RESERVED

111 Statistics: Flow average [m3/h] AV Flow

112 Statistics: Flow running 
average

[m3/h] AV Tau Flow

113 Statistics: Flow standard 
deviation

[%] SD Flow

114 Statistics: Flow running 
standard deviation

[%] SD Tau Flow

115 Statistics: SoS average [m/s] AV SoS

116 Statistics: SoS standard 
deviation 

[%] SD SoS

117...124 Statistics: Path 1-8, velocity 
average

[m/s] PATH AV Velocity

125...132 Statistics: Path 1-8, velocity 
standard deviation 

[%] PATH SD Velocity

133...140 Statistics: Path 1-8, SoS 
average

[m/s] PATH AV SoS

Start address
NotModiconComp

Short description Default unit Internal Register Name
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10.10.7  Holding Registers (read/write): Float (32-bit) floating-point; basic address 8000

141...148 Statistics: Path 1-8, SoS 
standard deviation

[%] PATH SD SoS

149...156 Statistics: Path 1-8, Gain 
average

[dB] PATH AV Gain

157...164 Statistics: Path 1-8, Gain 
standard deviation

[%] PATH SD Gain

165...172 Statistics: Path 1-8, SNR 
average

[dB] PATH AV SNratio

173...180 Statistics: Path 1-8, SNR 
standard deviation

[%] PATH SD SNratio

181...188 Statistics: Path 1-8, 
Acceptance average

[%] PATH AV Acceptance

189...196 Statistics: Path 1-8, 
Acceptance standard deviation

[%] PATH SD Acceptance

INFORMATION!
Register reserved for testing communications and protocol handling with this type of register, 
without affecting the operation of the flowmeter.

Start address
NotModiconComp

Short description Default unit Internal Register Name

1 Test register [ ] t.b.d.

2 Meter Constant forward [ ] Remote MC Fwd

3 Meter Constant reverse [ ] Remote MC Rev

4...10 RESERVED

11 Modbus Input Temperature 
Body

[oC] A:/IO/Inputs/Link for 
measured value/Temperature 
Body

12 Modbus Input Temperature 
Line

[oC] A:/IO/Inputs/Link for 
measured value/Temperature 
Line

13 Modbus Input Temperature 
Sampler 

[oC] A:/IO/Inputs/Link for 
measured value/Temperature 
Sampler

14 Modbus Input Pressure Line [barG] A:/IO/Inputs/Link for 
measured value/Pressure Line

15 Modbus Input Viscosity 
Kinematic

[cSt] A:/IO/Inputs/Link for 
measured value/ViscosityKin

16 Modbus Input Viscosity 
Dynamic

[cSt] A:/IO/Inputs/Link for 
measured value/ViscosityDyn

17 Modbus Input Density A:/IO/Inputs/Link for 
measured value/Density

18 Modbus Input Spare1 [ ] A:/IO/Inputs/Link for 
measured value/Spare1

19 Modbus Input Spare2 [ ] A:/IO/Inputs/Link for 
measured value/Spare2

20 Modbus Input Spare3 [ ] A:/IO/Inputs/Link for 
measured value/Spare3

Start address
NotModiconComp

Short description Default unit Internal Register Name



10 MODBUS PROTOCOL DESCRIPTION AND SET-UP 

146 

ALTOSONIC 5

www.krohne.com 01/2016 - 4004360702 - MA ALTOSONIC 5 en R02

10.10.8  Input Registers (read-only): Long long (64-bit integer); basic address range 9000

21 Modbus Input Spare4 [ ] A:/IO/Inputs/Link for 
measured value/Spare4

22 Modbus Input Spare5 [ ] A:/IO/Inputs/Link for 
measured value/Spare5

23 OVERRIDE Temperature Body [oC] Override Value TempBody

24 OVERRIDE Temperature Line [oC] Override Value TempLine

25 OVERRIDE Temperature 
Sampler 

[oC] Override Static TempSamp

26 OVERRIDE Pressure Line [barG] Override Value Presline

27 OVERRIDE Viscosity Kinematic [cSt] Override Value ViscoKin

28 OVERRIDE Viscosity Dynamic [cP] Override Value ViscoDyn

29 OVERRIDE Density [kg/m3] Override Value Density

30 OVERRIDE Spare1 [ ] Override Spare1

31 OVERRIDE Spare2 [ ] Override Spare2

32 OVERRIDE Spare3 [ ] Override Spare3

33 OVERRIDE Spare4 [ ] Override Spare4

34 OVERRIDE Spare5 [ ] Override Spare5

Start address
NotModiconComp

Short description Default unit Internal Register Name

1 Test register TestRegister uint64

2 Resetable Totaliser RELIAB 
Gross Forward

m3 Gross_Fwd_RELIAB

3 Resetable Totaliser RELIAB 
Gross Reverse

m3 Gross_Rev_RELIAB

4 Resetable Totaliser FAIL Gross 
Forward

m3 Gross_Fwd_FAIL

5 Resetable Totaliser FAIL Gross 
Reverse

m3 Gross_Rev_FAIL

6 Resetable Totaliser SUM Gross 
Forward

m3 Gross_Fwd_SUM

7 Resetable Totaliser SUM Gross 
Reverse

m3 Gross_Rev_SUM

8 NON-Resetable Totaliser 
RELIAB Gross Forward

m3 GrossNR_Fwd_RELIAB

9 NON-Resetable Totaliser 
RELIAB Gross Reverse

m3 GrossNR_Rev_RELIAB

10 NON-Resetable Totaliser FAIL 
Gross Forward

m3 GrossNR_Fwd_FAIL

11 NON-Resetable Totaliser FAIL 
Gross Reverse

m3 GrossNR_Rev_FAIL

12 NON-Resetable Totaliser SUM 
Gross Forward

m3 GrossNR_Fwd_SUM

13 NON-Resetable Totaliser SUM 
Gross Reverse

m3 GrossNR_Rev_SUM

Start address
NotModiconComp

Short description Default unit Internal Register Name
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10.10.9  Input Registers (read only): String (16 character); basic address 14000

10.11  Modbus mapping assignments

The available data is grouped in four levels:

1. Primary data
2. Reserved
3. Reserved
4. Reserved
5. Data for analysis
6. Control data
7. User settings
8. Reserved
9. Data not used

The data is grouped by data type.

10.12  CRC codes

Appendix A: Time out values
The character length lies between 9 and 12 bits. 
The UFP-5 determines the time between two bytes to recognise a communication failure or the 
end of a message. UFP-5 discriminates between a timeout between 2 bytes and a timeout after 
the last byte, which occurs at the end of a message.
The time between two bytes is measured with a resolution of ±100 µs. 
To detect the timeout state (end of message) a timer is incremented every millisecond. A 

INFORMATION!
Register reserved for testing communications and protocol handling with this type of register, 
without affecting the operation of the flowmeter.

Start address
NotModiconComp

Short description Unit Internal Register Name

1 CRC checksum Custody 
transfer parameters

text 16 ch t.b.d.

2 CRC checksum Custody 
transfer Application 
parameters

text 16 ch t.b.d.

3 CRC checksum Custody 
transfer Software engine

text 16 ch t.b.d.

4 Flow meter Type text 32 ch t.b.d.

5 Serial number text 32 ch t.b.d.

6 Project number/name text 64 ch t.b.d.

7 Tagnumber text 32 ch t.b.d.

8 Pipe size text 64 ch t.b.d.

9 Customer text 40 ch t.b.d.

10 Location text 40 ch t.b.d.

11 Station text 40 ch t.b.d.
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received byte will reset the timer. Every millisecond the timer value will be checked for a timeout 
value, when it will exceed a defined value it will mark the last received byte as end of message.
Notice that the serial communication is a asynchrony process with respect to the used timer 
interrupt, therefore a ‘jitter’ of 1 ms must be taken into account. 

Modbus defined timeout values for every baud rate with N number of bytes:

The maximum time to detect a timeout (end of message) used in UFP 5:

The maximum time between 2 characters in a message (GAP) used in UFP 5:

Appendix B: LRC Generation
(as taken from the website: www.modicon.com/techpubs/crc7.html)
The Longitudinal Redundancy Check (LRC) field is one byte, containing an eight-bit binary value. 
The LRC value is calculated by the transmitting device, which appends the LRC to the message. 
The receiving device recalculates an LRC during receipt of the message, and compares the 
calculated value to the actual value it received in the LRC field. If the two values are not equal, an 
error results.
The LRC is calculated by adding together successive eight-bit bytes in the message, discarding 
any carries, then two's complementing the result. The LRC is an eight-bit field, therefore each 
new addition of a character that would result in a value higher than 255 decimal simply rolls over 
the field's value through zero. Because there is no ninth bit, the carry is discarded automatically. 
Generating an LRC
Step 1:
Add all bytes in the message, excluding the starting colon and ending CRLF. Add them into an 
eight-bit field, so that carries will be discarded.

Baud 
rate

9 bit 10 bit 11 bit 12 bit

Timeout
chars

3.5 4.0 3.5 4.0 3.5 4.0 3.5 4.0

1200 26.25 ms 30 ms 29.17 ms 33.34 ms 32.08 ms 36.67 ms 35.00 ms 40 ms

2400 13.16 ms 15 ms 14.58 ms 6.67 ms 16.04 ms 18.33 ms 17.50 ms 20 ms

4800 6.56 ms 7.5 ms 7.29 ms 8.33 ms 8.02 ms 9.17 ms 8.75 ms 10 ms

9600 3.28 ms 3.75 ms 3.65 ms 4.16 ms 4.01 ms 4.58 ms 4.38 ms 5 ms

19200 1.64 ms 1.88 ms 1.82 ms 2.08 ms 2.01 ms 2.29 ms 2.19 ms 2.5 ms

Baud rate 9 10 11 12

1200 28...29 ms 31...32 ms 33...34 ms 36...37 ms

2400 14...15 ms 15...16 ms 16...17 ms 18...19 ms

4800 6...7 ms 7...8 ms 8...9 ms 9...10 ms

9600 3...4 ms 3...4 ms 4...5 ms 4...5 ms

19200 2...3 ms 2...3 ms 2...3 ms 2...3 ms

Baud rate 9 10 11 12

1200 28.2 ms 31.3 ms 34.4 ms 37.5 ms

2400 14.1 ms 15.6 ms 1.27 ms 8.8 ms

4800 7.0 ms 7.8 ms 8.6 ms 9.4 ms

9600 3.5 ms 3.9 ms 4.3 ms 4.7 ms

19200 1.8 ms 1.95 ms 2.2 ms 2.4 ms
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Step 2:
Subtract the final field value from FF hex (all 1's), to produce the ones-complement.
Step 3:
Add 1 to produce the two's-complement.
Put the LRC into the Message Pl 
When the eight-bit LRC (two ASCII characters) is transmitted in the message, the high order 
character will be transmitted first, followed by the low order character, e.g. if the LRC value is 61 
hex (0110 0001): 

Figure 8 LRC Character Sequence

Example
An example of a C language function performing LRC generation is shown below.
The function takes two arguments:
unsigned char *auchMsg ; A pointer to the message buffer containing binary data to be used for 
generating the LRC
unsigned short usDataLen ; The quantity of bytes in the message buffer. The function returns the 
LRC as a type unsigned char.
LRC Generation Function 
static unsigned char LRC(auchMsg, usDataLen) 
unsigned char *auchMsg ; /* message to calculate */ 
unsigned short usDataLen ; /* LRC upon quantity of */
/* bytes in message */
{ 
unsigned char uchLRC = 0 ; /* LRC char initialized */ 
while (usDataLen--) /* pass through message */ 
uchLRC += *auchMsg++ ; /* buffer add buffer byte*/ 
/* without carry */ 
return ((unsigned char)(-((char_uchLRC))) ;
 /* return twos complemen */ 
}
Appendix C: CRC generation
(As taken from the website: www.modicon.com/techpubs/crc7.html)
The Cyclical Redundancy Check (CRC) field is two bytes, containing a 16-bit binary value. The 
CRC value is calculated by the transmitting device, which appends the CRC to the message. The 
receiving device recalculates a CRC during receipt of the message, and compares the calculated 
value to the actual value it received in the CRC field. If the two values are not equal, an error 
results.
The CRC is started by first preloading a 16-bit register to all 1's. Then a process begins of 
applying successive eight-bit bytes of the message to the current contents of the register. Only 
the eight bits of data in each character are used for generating the CRC. Start and stop bits, and 
the parity bit, do not apply to the CRC.
During generation of the CRC, each eight-bit character is exclusive ORed with the register 
contents. The result is shifted in the direction of the least significant bit (LSB), with a zero filled 
into the most significant bit (MSB) position. The LSB is extracted and examined. If the LSB was a 
1, the register is then exclusive ORed with a preset, fixed value. If the LSB was a 0, no exclusive 
OR takes place.
This process is repeated until eight shifts have been performed. After the last (eighth) shift, the 
next eight-bit character is exclusive ORed with the register's current value, and the process 
repeats for eight more shifts as described above. The final contents of the register, after all the 
characters of the message have been applied, is the CRC value. 

Colon Addr. Fct. Data 
Count

Data Data Data Data LRC Hi LRC 
Lo

CR LF

6 1
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Generating a CRC
Step 1
Load a 16-bit register with FFFF hex (all 1's). Call this the CRC register. 
Step 2 
Exclusive OR the first eight-bit byte of the message with the low order byte of the 16-bit CRC 
register, putting the result in the CRC register. 
Step 3 
Shift the CRC register one bit to the right (toward the LSB), zerofilling the MSB. Extract and 
examine the LSB. 
Step 4
If the LSB is 0, repeat Step 3 (another shift). If the LSB is 1, Exclusive OR the CRC register with 
the polynomial value A001 hex (1010 0000 0000 0001). 
Step 5 
Repeat Steps 3 and 4 until eight shifts have been performed. When this is done, a complete 
eight-bit byte will have been processed. 
Step 6 
Repeat Steps 2 ... 5 for the next eight-bit byte of the message. Continue doing this until all bytes 
have been processed. 
Result 
The final contents of the CRC register is the CRC value. 
Step 7 
When the CRC is placed into the message, its upper and lower bytes must be swapped as 
described below. 
Put the CRC into the Message
When the 16-bit CRC (two eight-bit bytes) is transmitted in the message, the low order byte will 
be transmitted first, followed by the high order byte, e.g. if the CRC value is 1241 hex (0001 0010 
0100 0001): 

Figure 9 CRC Byte Sequence

Example 
An example of a C language function performing CRC generation is shown on the following 
pages. All of the possible CRC values are preloaded into two arrays, which are simply indexed as 
the function increments through the message buffer. One array contains all of the 256 possible 
CRC values for the high byte of the 16-bit CRC field, and the other array contains all of the values 
for the low byte.
Indexing the CRC in this way provides faster execution than would be achieved by calculating a 
new CRC value with each new character from the message buffer. 
Note: This function does the swapping of the high/low CRC bytes internally. The bytes are 
already swapped in the CRC value that is returned from the function. Therefore the CRC value 
returned from the function can be directly placed into the message for transmission. 
The function takes two arguments: 
unsigned char *puchMsg ; A pointer to the message buffer containing binary data to be used for 
generating the CRC 
unsigned short usDataLen ; The quantity of bytes in the message buffer. 
The function returns the CRC as a type unsigned short. 
CRC Generation Function 
unsigned short CRC16(puchMsg, usDataLen) 
unsigned char *puchMsg ; /* message to calculate CRC upon */
unsigned short usDataLen ; /* quantity of bytes in message */
{ 

Addr. Fct. Data 
Count

Data Data Data Data CRC Lo CRC Hi

41 12
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unsigned char uchCRCHi = 0xFF ; /* high CRC byte initialized */ 
unsigned char uchCRCLo = 0xFF ; /* low CRC byte initialized */ 
unsigned uIndex ; /* will index into CRC lookup table */ 
while (usDataLen--) /* pass through message buffer */
 {
uIndex = uchCRCHi ^ *puchMsg++ ; /* calculate the CRC */ 
uchCRCHi = uchCRCLo ^ auchCRCHi[uIndex] ;
uchCRCLo = auchCRCLo[uIndex] ;
}
return (uchCRCHi << 8 | uchCRCLo) ;
}
High Order Byte Table
/* Table of CRC values for high-order byte */ 
static unsigned char auchCRCHi[] = { 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 
0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 
0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 
0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 
0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 
0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 
0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 
0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40
} ; 
Low Order Byte Table 
/* Table of CRC values for low-order byte */ 
static char auchCRCLo[] = { 
0x00, 0xC0, 0xC1, 0x01, 0xC3, 0x03, 0x02, 0xC2, 0xC6, 0x06, 
0x07, 0xC7, 0x05, 0xC5, 0xC4, 0x04, 0xCC, 0x0C, 0x0D, 0xCD, 
0x0F, 0xCF, 0xCE, 0x0E, 0x0A, 0xCA, 0xCB, 0x0B, 0xC9, 0x09, 
0x08, 0xC8, 0xD8, 0x18, 0x19, 0xD9, 0x1B, 0xDB, 0xDA, 0x1A, 
0x1E, 0xDE, 0xDF, 0x1F, 0xDD, 0x1D, 0x1C, 0xDC, 0x14, 0xD4, 
0xD5, 0x15, 0xD7, 0x17, 0x16, 0xD6, 0xD2, 0x12, 0x13, 0xD3, 
0x11, 0xD1, 0xD0, 0x10, 0xF0, 0x30, 0x31, 0xF1, 0x33, 0xF3, 
0xF2, 0x32, 0x36, 0xF6, 0xF7, 0x37, 0xF5, 0x35, 0x34, 0xF4,
0x3C, 0xFC, 0xFD, 0x3D, 0xFF, 0x3F, 0x3E, 0xFE, 0xFA, 0x3A, 
0x3B, 0xFB, 0x39, 0xF9, 0xF8, 0x38, 0x28, 0xE8, 0xE9, 0x29, 
0xEB, 0x2B, 0x2A, 0xEA, 0xEE, 0x2E, 0x2F, 0xEF, 0x2D, 0xED, 
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0xEC, 0x2C, 0xE4, 0x24, 0x25, 0xE5, 0x27, 0xE7, 0xE6, 0x26, 
0x22, 0xE2, 0xE3, 0x23, 0xE1, 0x21, 0x20, 0xE0, 0xA0, 0x60, 
0x61, 0xA1, 0x63, 0xA3, 0xA2, 0x62, 0x66, 0xA6, 0xA7, 0x67, 
0xA5, 0x65, 0x64, 0xA4, 0x6C, 0xAC, 0xAD, 0x6D, 0xAF, 0x6F, 
0x6E, 0xAE, 0xAA, 0x6A, 0x6B, 0xAB, 0x69, 0xA9, 0xA8, 0x68, 
0x78, 0xB8, 0xB9, 0x79, 0xBB, 0x7B, 0x7A, 0xBA, 0xBE, 0x7E, 
0x7F, 0xBF, 0x7D, 0xBD, 0xBC, 0x7C, 0xB4, 0x74, 0x75, 0xB5, 
0x77, 0xB7, 0xB6, 0x76, 0x72, 0xB2, 0xB3, 0x73, 0xB1, 0x71, 
0x70, 0xB0, 0x50, 0x90, 0x91, 0x51, 0x93, 0x53, 0x52, 0x92, 
0x96, 0x56, 0x57, 0x97, 0x55, 0x95, 0x94, 0x54, 0x9C, 0x5C, 
0x5D, 0x9D, 0x5F, 0x9F, 0x9E, 0x5E, 0x5A, 0x9A, 0x9B, 0x5B, 
0x99, 0x59, 0x58, 0x98, 0x88, 0x48, 0x49, 0x89, 0x4B, 0x8B, 
0x8A, 0x4A, 0x4E, 0x8E, 0x8F, 0x4F, 0x8D, 0x4D, 0x4C, 0x8C,
0x44, 0x84, 0x85, 0x45, 0x87, 0x47, 0x46, 0x86, 0x82, 0x42, 
0x43, 0x83, 0x41, 0x81, 0x80, 0x40 
} ; 
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KROHNE – Process instrumentation and measurement solutions

• Flow

• Level

• Temperature

• Pressure

• Process Analysis

• Services

Head Office KROHNE Messtechnik GmbH
Ludwig-Krohne-Str. 5
47058 Duisburg (Germany)
Tel.: +49 203 301 0
Fax: +49 203 301 10389
info@krohne.com
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The current list of all KROHNE contacts and addresses can be found at:
www.krohne.com


